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Using This Book

Audience

This guide is intended for SAS Strategy Management 5.6 system administrators.

This book applies to release 5.6 of the SAS Strategy Management. It describes
a three-phase migration approach:

1

Upgrading your SAS Strategy Management X.4 content and configuration
from SAS 9.1.3 to SAS 9.2.

Subsequently upgrading your SAS Strategy Management 5.X content and
configuration from SAS 9.2 to SAS 9.4.

Upgrading your SAS Strategy Management 5.5 content and configuration to
version 5.6 on SAS 9.4.

If your installation is on SAS 9.1.3, you must complete all phases of the
migration.

If your installation is on SAS 9.2 or 9.3, you must complete the second and third
phases of the migration.

If your installation is on SAS 9.4 with SAS Strategy Management 5.5, you
complete the third phase of the migration.

If you are performing a migration, begin with this document. Refer also to the
documents listed in “Recommended Reading” on page xvii.

If you have a SAS Strategy Management 5.6 installation and you want to
migrate (copy) it to another system, see “Part 4. Fully Promoting a SAS
Strategy Management 5.6 Installation to Another System.”



xii

Documentation Conventions

Directory Paths

Directory Paths Used by Earlier Installations

This book uses the following documentation conventions to identify directory
paths used by SAS Strategy Management, version 5.4 and earlier, installations:

Path

Isasroot

Isasroot

Isasroot

SAS-config-dir

MySQL-install-dir

Refers to

Path to the SAS root
directory in a SAS 9.1.3
installation

Path to the SAS root
directory in a SAS 9.2
installation

Path to the SAS root
directory in a SAS 9.3
installation

Path to the SAS
configuration directory

Path to the MySQL
installation directory

Example

Windows: ¢:\Program Files\SAS\SAS 9.1
UNIX: /usr/local/sas/SAS 9.1

Windows: C:\Program Files\SAS\SASFoundation
\9.2

UNIX: /usr/local/SAS/SASFoundation/9.2

Windows: C: \Program Files\SAS\SASFoundation
\9.3

UNIX: /usr/local/SAS/SASFoundation/9.3

Windows: ¢:\sAS\Config
UNIX: /usr/local/SAS/config

Windows: C:\MySQL\bin
UNIX: /usr/local/mysql

Note: As of SAS Strategy Management 5.5, MySQL is
no longer supported. For more information, see SAS

Strategy Management 5.5: System Administration Guide.

Directory Paths Used by a Version 5.5 or 5.6 Installation

This book uses the following documentation conventions to identify directory
paths that are used by SAS Strategy Management version 5.6:

Path Refers to Example
!sasroot Path to the SAS root Windows: ¢:\Program Files\SASHome
directory \SASFoundation\9.4
UNIX: /usr/local/install/SASHome/
SASFoundation/9.4
Isasinst Path to the SAS Windows: C:\Program Files\SASHome

installation directory UNIX: /usr/local/install/SASHome

Path to the SAS
configuration directory

SAS-config-dir Windows: ¢:\sAS\Config

UNIX: /usr/local/SAS/config



Terms

Note:

Documentation Conventions Xiii

The name of the configuration directory and the level number might be

different at your site.

If your configuration is the result of a migration from the previous release of
SAS Solutions Services, the sasapp directory might be called sAsMain
instead (for example, c:\SAS\Config\Levl\SASMain rather than c:\sas
\Config\Lev1\SASApp). Make the appropriate substitutions as you read

this document.

File system pathnames are typically shown with Windows separators (\); for
UNIX, substitute a forward slash (/).

Some code examples contain line breaks (indicated by an underscore _ at
the end of the line) so that the code fits on the line. If you copy the code,
remove the underscores and line breaks.

This book uses the following terms:

Term

data tier

metadata tier

middle tier

single-tier installation

multi-tier installation

Description

The system on which you install the data-tier software for
SAS Strategy Management.

The system on which you installed the SAS Metadata
Server. Usually, this is the same system as the data tier.

The system on which you installed the Web application
server and on which your Web applications run.

An installation that is done on one system. In that case, the
single system functions as both the data tier and the middle
tier, and you should follow instructions for both the data tier
and the middle tier.

An installation that is done on more than one system (for
example, with a data tier and a middle tier).
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Accessibility

For information about the accessibility of this product, see Accessibility Features
of SAS Strategy Management 5.6 at support.sas.com.


http://support.sas.com/documentation/solutions/stm/5.6/en/accessibility/HTML/spma11y.htm
http://support.sas.com/documentation/solutions/stm/5.6/en/accessibility/HTML/spma11y.htm
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Recommended Reading

Refer to the following documents to assist with your installation and migration
from SAS 9.1.3 to SAS 9.2:

For SAS Performance Management Solutions and SAS Strategy
Management:

Installation Instructions for Release 5.2 of the SAS Performance
Management Solutions. This book contains instructions for installing third-
party software, creating users, and installing and configuring the SAS
Performance Management software, including SAS Strategy
Management software.

SAS Solutions Services: System Administration Guide. This book
contains additional configuration and administration information, as well
as a list of changes in SAS Solutions Services.

SAS Solutions Services: Data Administration Guide. This book contains
information about loading and managing data for the solutions.

These documents (and others) are available at http://support.sas.com/
documentation/onlinedoc/stm.

Note: This site is password-restricted. You can find the user name and
password in the pre-installation checklist or by calling Technical Support.

For the SAS Intelligence Platform:
SAS Intelligence Platform: 9.1.3 to 9.2 Migration Guide
SAS Intelligence Platform: Installation and Configuration Guide
What's New in SAS 9.2 Intelligence Platform

These documents (and others) are available at http://support.sas.com/
92administration.

What's New in SAS Information Delivery Portal , available at http://
support.sas.com/documentation.

Refer to the following documents to assist with your installation and migration
from SAS 9.2 to SAS 9.4 or with a full promotion:

For SAS Strategy Management:

Installation Instructions for Release 5.6 of SAS Strategy Management.
This book contains instructions for installing third-party software, creating
users, and installing and configuring the SAS Strategy Management
software.

SAS Strategy Management 5.6: System Administration Guide. This book
contains additional configuration and administration information, as well
as a list of changes in SAS Strategy Management.

These documents (and others) are available at http://support.sas.com/
documentation/onlinedoc/stm.


http://support.sas.com/documentation/onlinedoc/stm
http://support.sas.com/documentation/onlinedoc/stm
http://support.sas.com/92administration
http://support.sas.com/92administration
http://support.sas.com/documentation
http://support.sas.com/documentation
http://support.sas.com/documentation/onlinedoc/stm
http://support.sas.com/documentation/onlinedoc/stm

xviii Recommended Reading

Note: This site is password-restricted. You can find the user name and
password in the pre-installation checklist or by calling Technical Support.

For the SAS Intelligence Platform:
SAS 9.4 Intelligence Platform: Migration Guide
SAS 9.4 Intelligence Platform: Installation and Configuration Guide
SAS 9.4 Intelligence Platform: Guide to Software Updates
What's New in SAS 9.4 Intelligence Platform

These documents (and others) are available at http://support.sas.com/
94administration.

What's New in SAS Information Delivery Portal, available at http://
support.sas.com/documentation.

For a complete list of SAS books, go to support.sas.com/bookstore. If you have
questions about which titles you need, please contact a SAS Book Sales
Representative:

SAS Books

SAS Campus Drive

Cary, NC 27513-2414

Phone: 1-800-727-3228

Fax: 1-919-677-8166

E-mail: sasbook@sas.com

Web address: support.sas.com/bookstore


http://support.sas.com/94administration
http://support.sas.com/94administration
http://support.sas.com/documentation
http://support.sas.com/documentation
mailto:sasbook@sas.com
http://support.sas.com/bookstore
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Required Information to Read

If SAS Strategy Management is included in the installation plan for your SAS
9.1.3 system, there is no direct migration path to SAS 9.4. You must complete all
phases of the migration. This is true even if there are other products in the
installation plan which support a direct migration to SAS 9.4 without SAS
Strategy Management. Make sure that you read and complete the required
migration phases as described in the following table:

Table 1.1 Parts to Read When Migrating to SAS Strategy Management 5.6 on SAS 9.4

Current Installation Read and Complete

SAS Strategy Management 1 Migrating from SAS 9.1.3 to SAS 9.2 (Part 1)
2.40nSAS9.1.3
2 Migrating from SAS 9.2 to SAS 9.4 (Part 2)

SAS Strategy Management Migrating from SAS 9.2 to SAS 9.4 (Part 2)
5.1 0n SAS 9.2

SAS Strategy Management
5.20n SAS 9.2

SAS Strategy Management Migrating from SAS 9.3 to SAS 9.4 (Part 3)
5.3 0n SAS 9.3

SAS Strategy Management
5.4 on SAS 9.3

SAS Strategy Management Migrating from SAS Strategy Management 5.5 to
5.50n SAS 94 Version 5.6 on SAS 9.4 (Part 4)

SAS Strategy Management Fully Promoting a SAS Strategy Management 5.6
5.6 on SAS 9.4 Installation to Another System (Part 5)

Be aware of the following notes and restrictions:

You cannot migrate installations that are prior to SAS Strategic Performance
Management Version X.4.
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If you are migrating SAS Strategic Performance Management 2.4, you can
partially promote an installation as an alternative to migration. For more
information, see Appendix 1, “Partial Promotion Migration,” on page 121 .

You cannot use the SAS Migration Utility and the Software Deployment
Wizard to migrate the SAS Intelligence Platform and then rerun the same
software to migrate SAS Strategy Management later in the same deployment
configuration.

If you are installing new products in addition to migrating old ones, first
complete the migration of the old installation. Then install the new products.

Note: All documentation referred to in this part are listed in “Recommended
Reading” on page xvii.



Preliminary Tasks

Requirements

Creating Operating System Accounts
Required External Accounts
Optional External Accounts
The SAS Installer Account
The Sasspusr Account Not Needed

Performing Checks Before You Run the SAS Migration Utility
Overview
(Data Tier) Check the Required Hot Fix Level
(Data Tier) Update the Metadata for SAS Data Integration Studio
(Data Tier) Run the Diagnostic Tool

Installing the SAS Migration Utility
Overview
Install on a Windows System
Install on a UNIX System

Running the SAS Migration Utility

Check the SAS Migration Utility Migration Package
Repeat for Each System

(Data Tier) Modify Data Set Names If Necessary

WO NN N NOOO O

A A A
o O O o

P G |
H b W O

Requirements

This document is written with the following assumptions:

¥ You have prepared for a standard installation (such as installing required
third-party applications, planning which tiers are going to be installed on
which systems, and so on).

See the pre-installation steps in Installation Instructions for Release 5.2 of
the SAS Performance Management Solutions. For migration-specific
information about external accounts, see “Creating Operating System
Accounts” on page 6.

® You have prepared a software depot and an installation plan file.
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Creating Operating System Accounts

Required External Accounts

Create the required external accounts for the primary users in the operating
system . The required accounts are listed in the pre-installation checklist. You
define external accounts outside the metadata repository (for example, in the
operating system).

When you are installing software and migrating from SAS 9.1.3, you should use
the new SAS 9.2 internal accounts.

The following table summarizes the required external accounts and the
differences between external accounts in SAS 9.1.3 and SAS 9.2.

Table 2.1 Required External User Accounts

External Account (SAS 9.1.3) External Account (SAS 9.2) Example (SAS 9.2)
SAS Installer SAS Installer domain\installer-ID
SAS General Server User SAS Spawned Servers account domain\sassrv

SAS Demo User

not applicable

SAS First User domain\sasdemo

Note: The sasdemo account is
optional. If you include this identity,
it must refer to an external account.

Solutions Host User domain\sassin

Note: The domain variable is not used for UNIX accounts.

For more information about the account that you must use when you are
installing software and performing a migration, see “The SAS Installer Account”
on page 7.

Optional External Accounts

The following external accounts are required only if you do not use the new SAS
9.2 external accounts:

Table 2.2 COptional External User Accounts

External Account (SAS 9.1.3) External Account (SAS 9.2) Example (SAS 9.2)

SAS Administrator

SAS Trusted User

SAS Administrator domain\sasadm

SAS Trusted User domain\sastrust

Solutions Role Administrator Solutions Role Administrator domain\sinadm
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Note: The domain variable is not used for UNIX accounts.

The SAS Installer Account

The SAS Installer account must be the same account that was used to install
SAS 9.1.3. The account must have a corresponding metadata identity, with
membership in the Administrators group and in the MySQL Users group.

In Windows environments, this user must be a member of the Administrators
group in the operating system.

In UNIX environments, this user's profile must be the same as the SAS 9.1.3
profile, and must include the environment variables for MySQL. The following
example is for AlX:

# Path to the libdir in your mysqgl install
MYSQL LIBDIR=/usr/local/mysql/lib
export MYSQL LIBDIR

# Path to directory to hold shared library for SAS Access to MySQL
MYSQL CLIENT DIR=/usr/local/SAS/libmysql
export MYSQL CLIENT DIR

# Set or add to the shared library load path
LIBPATH=$SLIBPATH: $MYSQL CLIENT DIR

Or

LIBPATH=/usr/1lib/:/1ib:$MYSQL_ CLIENT DIR
export LIBPATH

# Add mysql/bin to the PATH environment variable
PATH=$PATH: /usr/local/mysql/bin
export PATH

Note: In UNIX environments, verify that the link-editor for object files, Id, is in
the SAS Installer’s path.

The Sasspusr Account Not Needed

X.4 installations required an additional user account, domain\sasspusr, for
access to the stored process server via the SPAuth domain. In migrated
systems, this user account is no longer required. For post-migration instructions,
see “Remove References to sasspusr and SPAuth” on page 28.

Performing Checks Before You Run the
SAS Migration Utility

Overview

On a single-tier system, perform all the pre-migration checks that are listed in
this section. On a multi-tier system, perform all the pre-migration checks on the
specified systems.
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(Data Tier) Check the Required Hot Fix Level

Before you migrate from the SAS 9.1.3 environment, complete the following
checks:

Check that the metadata server version is 9.1.3SP4. (In an interactive SAS
session, select Help » About.)

Check that hot fix E9BC59 has been applied by confirming the existence of
the file 1SASROOT\core\sasinst\hotfix\e9bc59wn.aud

Make sure that you followed the post-installation instructions when you
applied hot fix E9BC59.

CAUTION! Be sure to apply hot fix E9BC59 before you perform the migration.
If you already performed the migration, you must delete the configuration directories
and rerun the configuration pass of SAS Deployment Wizard. If you applied the hot
fix, but you are uncertain whether you followed the post-installation steps, follow
them now.

If the hot fix has not been applied, download and install the hot fix. Download the
appropriate hot fix for your operating system from the following Web address:
http://ftp.sas.com/techsup/download/hotfix/

e9 sbcs prod list.html#e9bc59.

The Readme file includes the post-installation steps.

(Data Tier) Update the Metadata for SAS Data
Integration Studio
CAUTION! Be sure to make this update before you perform the migration.

Otherwise, you must delete the configuration directories and rerun the configuration
pass of SAS Deployment Wizard.

Before you perform a migration, update the metadata for SAS Data Integration
Studio on the X.4 data tier:

1 Review the following SAS Note:

http://support.sas.com/kb/37/686.html

2 Download the JAR file and follow the SAS Note instructions.

(Data Tier) Run the Diagnostic Tool

The diagnostic tool ensures that the environment is ready for migration. It also
gathers information about the site's stageDDS, DDS, and SASSDM data models
and compares them to the corresponding SAS data models. For a successful
migration, there must be no critical differences between a site's data model and
the SAS data model. After you run the diagnostic tool, correct any critical
differences before you continue the migration.

On the X.4 system, run the diagnostic tool from SAS Data Integration Studio.
Complete the following steps:

1 In SAS Data Integration Studio, log on to the data tier as a power user (not
the unrestricted user). Select the Solutions repository as the default.


http://ftp.sas.com/techsup/download/hotfix/e9_sbcs_prod_list.html#e9bc59
http://ftp.sas.com/techsup/download/hotfix/e9_sbcs_prod_list.html#e9bc59
http://support.sas.com/kb/37/686.html
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Click the Inventory tab.

In the Solutions repository, right-click Jobs and select Import. Select
SAS_HOME\SASSolutionsServices\1.4\DataTier\Diagnostics
\DataModels\chk_dataModels_Job.spk as the package to import.

Note: Substitute 1.4.1 as the version number if necessary.
Open the chk_dataModels job.
Open the properties for the chk_dataModels transformation.

Click the Options tab and set the following options:

Directory (Input): Directory where the SAS dictionary tables are stored,
with names such as dictionary_14.sas7bdat or dictionary 13.sas7bdat.
The following values are the default directories:

Windows ..\Program Files\SAS\SASSolutionsServices\l.4\DataTier
\Diagnostics\DataModels

UNIX ../SAS/SASSolutionsServices/l.4/DataTier/ Diagnostics/
DataModels

Directory (Output): Directory where the HTML output reports are stored.
The following values are the default directories:

Windows ..\SAs\sASSolutionsConfig\Levl\Data

UNIX ./SAS/SASSolutionsConfig/Levl/Data

Keep the default values for the remaining options.
Execute the chk_dataModels job.

Open the log and check the output files that are produced by the
chk_dataModels job. The files are listed at the bottom of the log. Here is an
example:

NOTE: Check the following html documents:
- C:\SAs\SAsSSolutionsConfig\Levl\Data/diff site DDS version
1.4 09AUG10111604.html
- C:\SAsS\SAsSolutionsConfig\Levl\Data/diff site STAGEDDS version
1.4 09AUG10111604.html
C:\SAs\SASSolutionsConfig\Levl\Data/diff site SASSDM version
1.4 09AUG10111604.html

Only tables that differ from the standard model are listed in the report output.
If you see a column in the report whose data type and length match the
standard model, then only the label has been changed, and you can ignore
the difference. If a column is reported as missing in the site model, the case
of the column name in the site model is probably different than the case of
column name in the SAS model. You can safely ignore case differences in
column names. Investigate and correct any other differences to ensure a
valid migrated model.

If the HTML files are empty, no differences were found.
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Installing the SAS Migration Utility

Overview

The SAS Migration Utility is a tool that packages content from the SAS 9.1.3
installation so that it can be migrated to a new SAS 9.2 installation. For more
information about the SAS Migration Utility, see the SAS Intelligence Platform:
9.1.3 to 9.2 Migration Guide.

Install on a Windows System
To install the SAS Migration Utility on Windows:

1 Locate the directory named sassoftwareDepot\utilities\smu, where
SASSoftwareDepot is the directory where you downloaded the SAS Software
Depot.

This directory contains the smu.exe file, the smu.properties.template file, and
possibly other files and directories.

2 Copy the contents of the utilities\smu directory to a new directory on
each of the systems in your SAS 9.1.3 installation. For example, create c:
\Program Files\SAS\SASMigrationUtility\9.1.3 and copy the files
there.

Install on a UNIX System

To install the SAS Migration Utility on UNIX, use FTP to transfer the files from
the depot to a new directory on each of the systems in your SAS 9.1.3
installation.

Running the SAS Migration Utility

Before you run the SAS Migration Utility, create a shared directory on the
network that is available to all of the systems in the installation. This directory
becomes the SAS Migration Utility migration package directory. All SAS
Migration Utility output from all systems is stored in this directory.

Then perform the following steps on each system that requires migration. Begin
with the system that is running the SAS 9.1.3 Metadata Server:

1 Navigate to the directory to which you copied the contents of the utilities
\smu depot directory.

2 Copy the smu.properties.template file to smu.properties.

3 Edit the smu.properties file with a text editor.
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The smu.properties file is in the Java properties file format. The following
format rules are most important to apply when you are editing the

smu.properties file:

Lines that begin with the # character are comments and have no effect.

Backslash characters (\) must be doubled. For example, C:\\Program

Files\\SAS.

4 Review the entire smu.properties file and change property settings if you

need to.

The comments in the file explain each property that you must set. The
following table describes some specific properties:

Property

SMU.Output.Dir

SMU.password

SMU.SASROOT

SMU.spmmidtier.scorec
ard.ear.dir

Description

This property contains the path to the SAS Migration
Utility migration package directory.

Enter the path to the shared directory that you created
in step 1.

The smu.properties comments state that the
SMU.password property value must be encoded in the
{sas001} format using the PWENCODE procedure.
However, you can also specify a plain-text password. If
you choose to specify a plain-text password, for
security purposes, erase this password immediately
after you run the SAS Migration Utility.

For systems on which SAS is installed, enter the path
to the 1sasrooT directory. The following paths are two
examples:

SMU. SASROOT=C: \\Program Files\\SAS\\SAS 9.1
SMU. SASROOT=/usr/local/SAS/SAS 9.1

On a middle-tier system, comment out this property.

This property must be set only for sites with SAS
Solutions Services 1.4.1 and IBM WebSphere 6 on AIX:

Path to the deployed EAR file for SAS Strategic
Performance Management: webSphere-install-
dir/profiles/profile-name/installedApps/
network-cell-name/SAS Strategic Performance
Management.ear

WebSphere-install-dir is the path to the IBM
WebSphere root installation directory (such
as /usr/IBM/WebSphere/AppServer).

profile-name is the name of the application server
profile (such as Appsrvo01).

network cell name is the cell name of the
deployment manager node.

5 (For Windows installations only) Open a command window in the directory in
which you installed the SAS Migration Utility and submit one of the following

commands:
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Systems on
which the DAV
server is
running

Note: Either
Xythos or
Apache.

Other systems

smu.exe -s -a -davtier -properties
"full path to SMU install directory\smu.properties"

smu.exe -s -a -properties
"full path to SMU install directory\smu.properties"

Note: In these commands, quotation marks are required around
full_path_to SMU install_directory\smu.properties only if there is a space in

the pathname.

Note: You must specify the full path to the smu.properties file in the -
PROPERTIES option, even though the smu.properties file is in the current
directory (the same directory as the smu.exe file). The smu.exe file is actually
a self-extracting archive. It extracts the complete program into a separate,
temporary directory and runs the program from there.

After a few seconds, a second command window appears with the SAS
Migration Utility console output.

6 (For UNIX installations only) Submit one of the following commands (line
breaks added for readability):

Systems on

which the DAV

server is
running

Note: Either
Xythos or
Apache.

Other systems

./smu.sh -- -davtier -outputdir /usr/local/
SAS/smupackage-properties /usr/local/SAS/smu/
smu.properties

./smu.sh -- -outputdir /usr/local/SAS/smupackage-
properties /usr/local/SAS/smu/smu.properties

Note: The output directory must not be the same as the SAS Migration
Utility installation directory.

7 Wait for the SAS Migration Utility to finish running.

Check the output as described in “Check the SAS Migration Utility Migration
Package” on page 13. For additional troubleshooting help, see “Errors
Running the SAS Migration Utility” on page 129.
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Check the SAS Migration Utility Migration

Package

In the previous section, you set the SMU.Output.Dir property in the
smu.properties file to point to the SAS Migration Utility migration package
directory (the directory under which all migrated content is stored).

A subdirectory in the SAS Migration Utility migration package directory is named
after each system on which you run SAS Migration Utility. Inside this
subdirectory are other subdirectories. Each subdirectory contains content that
was backed up from a particular SAS product.

Note: Some subdirectories might be empty.

To check the SAS Migration Utility migration package:

1 After smu.exe completes, check the final few lines of output in the command
window to determine whether the SAS Migration Utility produced error
messages.

2 If the SAS Migration Utility produced error messages, complete the following
steps:

View the migrate.log file in the system's subdirectory inside the SAS
Migration Utility migration package directory to determine the cause of the
error.

Look for and correct any remaining errors. If you make corrections, rerun
the SAS Migration Utility and include the -replace option.

3 Review the migration status messages for the products that you are
migrating. Complete the following steps:

In the subdirectory named AnalysisReport, open the FullReport.html file
and review the messages.

There are migration status messages for each product. This report
indicates whether you must upgrade any products or install patches
before you can complete the migration.

Run the SAS Migration Utility after you install any patches.
Look for and correct any remaining error messages before you continue.

Examine all warning messages.
Note: Warning messages are for informational purposes.

Note: Warning messages are expected on most systems. For example, a
warning message appears in the Analysis Report for each data directory
that is found in metadata that exists outside of the SAS Configuration
directory. If these data directories are needed in the SAS 9.2 installation,
migrate them manually.

4 To verify that data has been backed up correctly, complete the following
additional checks:

Note: On the middle-tier system, ignore these steps.
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In the metadatasrv subdirectory, verify the existence of these
subdirectories: MetadataRepositories and rposmgr.

In the MetadataRepositories subdirectory, verify that one subdirectory
exists for each metadata repository.

In the wrs subdirectory, verify the existence of a subdirectory named
Areal.

The Areal subdirectory should contain the WFSDump.xml file as well as
several files with names that begin with X and end with a number.

In the soldatatier subdirectory, verify the existence of a sQL
subdirectory, which contains a file named sassdm.sq|.

Note: This file might be large (megabytes or hundreds of megabytes.)

In the spmdatatier subdirectory, verify the existence of a sQL
subdirectory, which contains a file named spm.sql.

Repeat for Each System

(Data Tier)
Necessary

Repeat the steps in “Running the SAS Migration Utility” on page 10 and “Check
the SAS Migration Utility Migration Package” on page 13 for every other system
that is in this installation (other than client systems).

Note: The FullReport.html file displays a failure (X-) for the SAS Metadata
Server Product if you run the smu.exe file on any tier other than the metadata
server system.

Modify Data Set Names If

If the physical names of any custom data sets in the STAGEDDS library meet
certain criteria, you must rename the data sets in the SAS Migration Utility
package before you install the 5.2 software. Complete the following steps:

1 Navigate to the path-to-SMU-package\data-tier-name\levconfig
\levdata\Data directory.

path-to-SMU-package is the directory in which the SAS Migration Utility
package was created.

data-tier-name is the name of the data-tier system.

2 Open the ZIP file in that directory and make the following changes:

Note: These changes apply regardless of whether the prefix is in uppercase,
lowercase, or mixed case.

If you find any data sets with a name that begins with STAGE_, rename
each such data set to begin with STG_ (or a similar string).
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b If you find any data sets with a name that is a single letter, rename each
such data set so that it has more than one letter in its name. For example,
if a file is named a.sasb7dat, rename it to aa.sasb7dat.
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Single-Tier Installation

Overview

Overview 17
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2. Perform the Instructions.html Tasks 18
3. Perform the Post-Migration Tasks 18

Read the instructions in this chapter. Then follow the installation steps in the
Installation Instructions for Release 5.2 of the SAS Performance Management
Solutions.

Note: The installation guide refers to the application server directory as sAsapp.
In a migrated system, this directory is typically named sasMain.

For installation and migration on the data tier (the system on which you installed
the SAS Solutions Services data-tier software), follow the installation and
configuration steps in “3. Perform the Post-Migration Tasks” on page 18.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: Select Perform Migration when the Migration
Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Creating Operating System Accounts” on page 6.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
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is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Note: MySQL and WebLogic account names are created in MySQL Server
and Oracle WebLogic. These are not operating system accounts. Do not add
a host name prefix to these account names.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. There is
typically a list of server contexts, which consist of the correct new server
context as well as all the migrated OLAP server contexts.

Choose the correct server context for your site. The default application server
context for a migrated system is SASMain.

Note: This application server context does not apply to the metadata server.

When you are asked to specify the database type to use for SAS Shared
Services, always select MySQL. The other database types that are listed,
including SAS Table Server, are not supported for migration.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

3. Perform the Post-Migration Tasks

Perform the post-migration tasks as described in Chapter 5, “Post-Migration
Tasks,” on page 23.
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Overview

For multi-tier installations, read the instructions in this chapter before you install
SAS Strategy Management. Then follow the installation steps in the Installation
Instructions for Release 5.2 of the SAS Performance Management Solutions.

Note: The installation guide refers to the application server directory as SASApp.
In a migrated system, this directory is typically named sAsMain.

Separate Metadata Tier Installation

If the data tier and metadata tier are on the same system, go to “Data-Tier
Installation on the Target System” on page 20.

Otherwise, complete the following steps:

1 Run the Software Deployment Wizard on the metadata tier first.

Select both Install SAS Software and Configure SAS Software as the
deployment type.

2 When the Migration Information page appears, select Perform migration.

3 After you complete the installation and configuration of the metadata tier, go
to “Data-Tier Installation on the Target System” on page 20.
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Data-Tier Installation on the Target System

Overview

For installation and migration on the data tier (the system on which you installed
the SAS Solutions Services data-tier software), complete the following
installation and configuration steps.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: Select Perform Migration when the Migration
Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Creating Operating System Accounts” on page 6.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Note: MySQL and WebLogic account names are created in MySQL Server
and Oracle WebLogic. These are not operating system accounts. Do not add
a host name prefix to these account names.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. There is
typically a list of server contexts, which consist of the correct new server
context as well as all the migrated OLAP server contexts.

Choose the correct server context for your site. The default application server
context for a migrated system is SASMain.

Note: This application server context does not apply to the metadata server.

When you are asked to specify the database type to use for SAS Shared
Services, always select MySQL. The other database types that are listed,
including SAS Table Server, are not supported for migration.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
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proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.

2. Perform the Instructions.html Tasks
Follow the steps in the Instructions.html file.

Next, go to “Installation on Additional Tiers” on page 21.

Installation on Additional Tiers

On every other tier (excluding client systems), complete the following steps.

1. Run the SAS Deployment Wizard
Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software.

Perform migration: Select Perform migration when the Migration
Information page appears.

(Middle tier) When you are asked to specify the database type to use for
SAS Shared Services, always select MySQL. The other database types that
are listed, including SAS Table Server, are not supported for migration.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

Post-Migration

After you install and configure all the systems (other than client systems),
perform the steps in Chapter 5, “Post-Migration Tasks,” on page 23.
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Post-Migration Tasks

Overview

Overview

Apply File Permissions

Migrate SAS Data Sets from 32-Bit to 64-Bit Microsoft Windows
(Optional) Modify Conform Library

Migrate Additional Libraries

Run the post_migration_tasks Job

Load Dimension Type Table

Update the Conform Folder Permissions

Update KPI and Scorecard Permission Assignments to SAS Demo User
Remove References to sasspusr and SPAuth

Modify Server and Library Names in %SPMEXPSC Macro

Run the update52.sql Script

Migrate SAS Web Report Studio Reports
Overview
Export the SAS Web Report Studio Reports
Import the Reports into the 5.2 Installation

SAS Bl Dashboard Modifications
Re-Create Indicator Data Definitions for Dashboards
Modify Indicator Definitions

Validate the Installation

This chapter contains tasks that must be performed after the installation and

23
24
24
25
26
26
26
26
27
28
28
29

29
29
30
31

32
32
33

34

migration steps are complete. Some tasks apply only to a particular solution, or

only to migrations from 32-bit Windows to 64-bit Windows environments.

Completing the tasks in this chapter requires the following:

¥ You must have completed the installation, configuration, and migration steps

that are outlined in the previous chapters of Part 1.

¥ You must have access to SAS Management Console in the SAS 9.2
installation.
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You must have access to SAS Data Integration Studio in the SAS 9.2
installation.

To run a SAS Data Integration Studio job, a user must have the following
group and role memberships:

Solutions Services: Data Administrator role (or the Data Administrators
group)

Solutions Users group

Note: Do not connect as the unrestricted user. The unrestricted user cannot
start a workspace server session.

Apply File Permissions

Before you perform any of the post-migration tasks, apply file permissions as
described in “Secure Your Installation” in the SAS Solutions Services: System
Administration Guide. Otherwise, some tasks in this chapter will fail.

In particular, apply the following permissions to the sAs-config-dir
\Lev1l\SASMain\Data directory and its subdirectories:

For Windows Grant Full Control to SAS General Server User (sassrv). Grant

installations Read/Write/Modify permission to users who run ETL or SAS jobs
to update data in the warehouse. These users should include the
Solutions Host User (sassln).

For UNIX Permit full access for the sas user ID and the sas user group.
installations

Migrate SAS Data Sets from 32-Bit to 64-Bit
Microsoft Windows

If you are migrating from 32-bit to 64-bit Microsoft Windows, you might need to
use the MIGRATE procedure to convert data sets in SAS libraries directory from
32-bit format to 64-bit format.

Libraries that are located under the sAs-config-dir directory (including DDS
and StageDDS) are automatically converted during migration.

However, after migration is complete, you must manually convert data sets in
any SAS libraries that are not located under the sas-config-dir. For more
information, see the SAS Note at http://support.sas.com/kb/
37/695.html


http://support.sas.com/kb/37/695.html
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(Optional) Modify Conform Library

During migration, the DDS, StageDDS, and ConformedDataMart data directories
are copied to a new location that conforms to SAS Performance Management
Solutions 5.2 conventions. The DDS and StageDDS data sets are also upgraded
to the SAS Performance Management Solutions 5.2 data model.

In SAS Performance Management Solutions 5.2, by default the Conform library
points to the same location as the Cross Industry Detail Data Store folder: sas-
config-dir\Levl\SASMain\Data\SolutionsServices\DDSData.

If you do not want to use a separate conform area, skip the rest of this section.

If you want to create a separate conform area, you must modify the Conform
LIBNAME statement, and you might need to upgrade its data sets. Follow these
steps:

1 Prepend the path for the ConformedDataMart to the Conform LIBNAME
statement:

a On the Plug-ins tab of SAS Management Console, navigate to
Environment Management » Data Library Manager » Libraries.

b Right-click Conform and open its properties.

c On the Options tab, add sas-config-dir\Levl\SASMain\Data
\SolutionsServices\ConformedDataMart to the path specification.

Replace SAS-config-dir with the path to your site's configuration directory.
If necessary, use the up or down arrows so that this path precedes the
path to DDSData.

2 If your site does not need the Conform data from the SAS 9.1.3 installation:
Copy the CrossindustryDDS data sets to the sAS-config-dir
\Levl\SASMain\Data\SolutionsServices\ConformedDataMart folder,
replacing all the data sets in that folder. Skip step 3.

3 If your site does need the Conform data from the SAS 9.1.3 installation:

a Manually upgrade the ConformedDataMart data sets to match the
CrossIndustryDDS data model. If a CrossindustryDDS data set contains
one or more columns that are not present in the corresponding
ConformedDataMart data set, add those columns to the
ConformedDataMart data set.

b If the tables are registered in the metadata repository: In SAS Data
Integration Studio, navigate to the Conform library. Select the table
appropriate table names, right-click, and then select Update Metadata.

For more information, see “Appendix 2: The Conform Area” in the SAS Solutions
Services: Data Administration Guide.
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Migrate Additional Libraries

SAS libraries that were in locations outside the configuration directory were not
automatically migrated. For more information, see “Migrating Content Stored
Outside of the SAS Configuration Directory” in the SAS Intelligence Platform:
9.1.3 to 9.2 Migration Guide.

Run the post_migration_tasks Job

This job executes a number of post-migration tasks.
1 In SAS Data Integration Studio, connect to the 5.2 metadata tier.

2 Run the post_migration_tasks job.

This job is located in the /Products/Cross Industry Detail Data
Store/Post Migration Tasks folder.

Load Dimension Type Table

After you run the post_migration_tasks job, load the CrossindustryDDS
Dimension Type table, using one of the following jobs:

the cind_dds_100400 load_dimension_type_table job, which is located in
the /Products/Cross Industry Detail Data Store/5.2 Jobs folder

It is recommended that you use this job at a site without custom dimensions.

the 100400 Load DDS DIMENSION_TYPE Table job, which is located in
the /Products/Cross Industry Detail Data Store/Migrated Jobs/
Detail Data Store (DDS)/Reference Table Jobs folder

We recommend using this job at a site with custom dimensions.

Before you execute the job, review it to make sure that all source-to-target
mappings are correct. Review the mapping in each transformation that is used
by the job and propagate or map columns as necessary.

Note: If you run the post_migration_tasks job more than once, you must reload
the CrossIndustryDDS Dimension Type table each time.

Update the Conform Folder Permissions

To update the Conform folder permissions:

1 Open SAS Management Console as the unrestricted user (sasadm).
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2 On the Plug-ins tab, select the Foundation repository.

3 Select Environment Management » User Manager.

4 Right-click the SAS Administrators group and select Properties.

5 Onthe Members tab, add solutions Role Administrator as a member.
6 Save your changes.

7 On the Folders tab of SAS Management Console, navigate to the
Products/SAS Solutions Services folder.

8 Right-click the conform folder and select Properties.

9 On the Authorization tab, grant the following permissions to the SAS
Administrators group:

ReadMetadata
WriteMetadata
WriteMemberMetadata
CheckinMetadata
Read
Administer
Deny the Write, Create, and Delete permissions to the SAS Administrators
group.
10 Click Add.

11 In the Add Users and Groups window, move the SASUSERS group to the
Selected Identities list. Click OK.

12 Grant SASUSERS ReadMetadata permission and deny all other
permissions.

13 Click OK to save the new properties.

Update KPI and Scorecard Permission
Assignments to SAS Demo User

To complete the migration for key performance indicator (KPI) or scorecard
projects, follow the instructions in SAS Note 37794, available at http://
support.sas.com/kb/37/794.html. These instructions adjust project,
scorecard, template, and element permissions for the SAS Demo User. In X.4
the permissions were assigned to SAS Demo User. In SAS 9.2 they are
assigned to sasdemo.

Note: In SAS 9.2, sasdemo is the user name; SAS Demo User is the display
name.


http://support.sas.com/kb/37/794.html
http://support.sas.com/kb/37/794.html
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Remove References to sasspusr and

SPAuth

X.4 installations required an additional user account, domain\sasspustr, for
access to the stored process server via the SPAuth domain. In migrated
systems, this user account is no longer required.

To remove references to this authentication domain, complete the following
steps:

1

In SAS Management Console, select the User Manager plug-in and open the
properties for the Solutions Users group.

Click the Accounts tab.
Delete the entry for sasspusr and save your changes.

Select Environment Management » Server Manager » SASMain
SASMain - Logical Stored Process Server » SASMain - Stored Process
Server and open the Connection properties.

Click the Options tab.

From the Authentication Domain list, select DefaultAuth and save your
changes.

Make the same change to each of the load balanced (LB) connection
definitions.

Modify Server and Library Names in
%SPMEXPSC Macro

Modify the SAS autocall macro %SPMEXPSC:

1

2

Log on to SAS Management Console as the administrator (sasadm).

On the Plug-ins tab, navigate to Environment Management » Server
Manager.

Select the server that has the Logical Workspace Server and the Logical
Stored Process Server. Note the name of this server (such as SASMain).

Navigate to Data Library Manager and locate the library whose name ends
with - SPMImapXport. This library usually contains the
GENERICSPMEXPORT table. Note the name of this SAS library (for
example, SASMain - SPMIimapXport).

Open the spmexpsc.sas file for editing.

On Windows, this file is located in the ! SASROOT\ scorecard\sasmacro
directory on the data tier.
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Note: Before you edit the spmexpsc.sas file, make a backup copy of it.

6 Find the line that contains infomapSASServer. It resembles the following
code, although the default SASApp value might have a different value):

$let infomapSASServer=SASApp;

Change the value of the server name to the server name that you observed
in SAS Metadata Console. (For the preceding example, you would change
SASApp to SASMain.)

7 Find the line that contains imapTableLibrary. It resembles the following
code (although the default sasapp value might be replaced by something
else):

%let imapTableLibrary=SASApp - SPMImapXport;

8 In that line, substitute the name of the library that you observed in SAS
Management Console. For the preceding example, you would modify the
code as follows:

%$let imapTableLibrary=SASMain - SPMImapXport;

9 Save the file.

Note: For more information about using the Export to Information Map feature
of SAS Strategy Management, see “SAS Strategy Management or KPI Viewer
Modifications” in the SAS Solutions Services: System Administration Guide.

Run the update52.sql Script
From a command prompt on the data tier, run the following command, which
updates the SPM database in MySQL:

cmd> mysqgl -hSPM-datatier-host -uspm-username -pspm-password spm
< SASHOME\SASStrategyManagementDataTier\5.2\Config\Deployment\SQL\update52.sql

Note: A line break was added for readability. You should enter the command on
a single line.

SPM-datatier-host is the host name of the data tier.

spm-username is the name of the MySQL administrative user for the SPM
database. The default user name is spmdbadm.

spm-password is the password for accessing the SPM database.
SASHOME is the path to the SAS installation directory.

Migrate SAS Web Report Studio Reports

Overview

In the X.4 release of the solutions, SAS Web Report Studio reports might be
stored in more than one repository (for example, the HR repository, the
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Solutions repository, and the Performance Management repository). By default,
the BIP Tree in each repository was mapped to the same DAV content location
(/sasdav/wrs). When the DAV content is migrated, all the content is stored in a
single DAV folder. (The folder that is selected depends on which repository's
BIP Tree folder is mapped first during the migration.)

You can verify the existence of multiple SAS 9.1.3 repositories by searching the
AnalysisReport.html file in your SAS Migration Utility package for a warning
similar to the following:

Content URL http://<DAV server>=8300/sasdav/wrs is mapped to by multiple
metadata roots: BIP Tree, BIP Tree, BIP Tree, BIP Tree

To repair the reports, you must export the X.4 reports and import them into your
5.2 system (replacing the migrated reports), as described in the following
sections. Otherwise, when users try to open a report, they might see a message
stating that the report is not accessible.

Note: If your X.4 system used a different content mapping for the /BIP Tree
folder in each repository, these steps are not necessary.

Export the SAS Web Report Studio Reports

To export the reports from the X.4 system, log on to SAS Management Console
9.1 as the unrestricted user (sasadm). In the Bl Manager plug-in, examine the
shared reports folder and the user reports folders in each repository. For each
folder that contains SAS Web Report Studio reports, follow these steps:

1 Navigate to the source directory.

For shared reports, the source directory is the /BIP Tree/ReportStudio/
Shared/Reports folder.

For users' personal reports, the source directory is the /BIP Tree/
ReportStudio/Users/username/Reports folder.

2 Select all the reports in the Reports folder, right-click, and select Export
from the pop-up menu.

3 In the Export wizard, select a destination for the export package:

a Click Browse to browse to the directory where the package file will be
exported.

Select a directory that is accessible from the 5.2 installation.

b Give the file a name that identifies the repository (and user, if these are
user reports), so that you can easily select the correct file to import.

c Click Open.

d If you are exporting shared reports, select the Include access controls
check box if you want to retain permissions that are associated with those
reports.

Note: If the access controls are based on an access control template
(ACT), make sure the ACT is defined in SAS 9.2 before you import these
reports.

If you are exporting users' personal reports, do not select the Include
access controls check box.
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e Click Next.

Select each of the reports to be migrated.

Do not select any dependent information maps for export.
Click Next.
Review the Summary and click Export.

Verify that the export process was successful and click Finish.

Import the Reports into the 5.2 Installation

On the 5.2 system, log on to SAS Management Console 9.2 as the unrestricted
user (sasadm). For each reports package that you exported from your X.4
system, follow these steps:

1

On the Folders tab, navigate to the target folder for the reports.

If you are importing shared reports, navigate to the /repository-name/BIP
Tree/ReportStudio/Shared/Reports folder (for example, /HR/BIP
Tree/ReportStudio/Shared/Reports).

If you are importing reports from a user's personal folder, navigate to the /
Users/username/My Folder/repository-name/Reports folder (for
example, /Users/sasdemo/My Folder/HR/Reports).

Note: You can import the exported reports to a different folder and delete
the old migrated reports.

Right-click the Reports folder and select Import SAS Package from the
pop-up menu.

Complete the Import SAS Package page, as follows:

a Click Browse and browse to the X.4 package file that corresponds to this
target folder.

b Select the file and click OK.

c If you saved access controls (for shared reports only), select the Include
access controls check box.

For users' personal reports, do not select this check box.

d Select the All objects radio button (the default), so that existing reports
with the same name are overwritten.

e Click Next.

On the Select Objects to Import page, select the reports to store in this folder
and click Next.

On the About Metadata Connections page, click Next.

On the Information Maps page, click Browse for each information map to
verify or select the target information map. By default, the correct target
information map (in the /BIP Tree/ReportStudio/Maps folder) should
already be selected. If the target information map is pointing to a different
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folder, navigate to the /BIP Tree/ReportStudio/Maps folder, select the
appropriate information map, and click OK.

Click Next.
Verify the summary and click Next to import the reports.

Verify that the import process was successful and click Finish.

SAS Bl Dashboard Modifications

Re-Create Indicator Data Definitions for

Dashboards

Overview

If your migration included dashboards (for SAS Bl Dashboard) that use the SAS
Strategy Management data provider, you must re-create the indicator data
definitions for those dashboards.

Export the Indicator Data Definitions

To export the indicator data definition (.imx) files from the metadata repository:

1

2

On the 9.2 system, log on to SAS Management Console as an administrator.
On the Folders tab, select Products » Bl Dashboard 4.3 » ModelConfigs.

In the right-hand pane, right-click an .imx file and select Write Content to
External File. Select a destination on your machine and export the file.

Repeat Step 2 and Step 3 for each .imx file.
Search the .imx files for the following string:
<ModelProviders>spm</ModelProviders>

The matching files are the files that you need to re-create. You cannot simply
modify the files and import them, but you can refer to their contents when you
re-create the indicator data definitions in SAS Bl Dashboard.

Re-Create the Indicator Data Definitions

To re-create the indicator data definitions:

1

2

Log on to the Dashboard Builder:
http://server:port/SASBIDashboard

server is the host name of the managed server to which you deployed
SAS Bl Dashboard.

port is the port number for the managed server.

Click Manage Dashboards.
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For each indicator data definition that must be re-created, follow these steps:

a In the Library view of the Objects pane, select Indicator Data from the
New drop-down list.

b In the Create Indicator Data dialog box, type the name of the .imx file
(without the extension), and then click OK.

c From the Data Source drop-down list, select SAS Strategy
Management 5.x.

d Define the indicator data. Note the following:

In the Scorecard Server URL field, type the URL to the SAS Strategy
Management application (as http://server:port/
SASStrategyManagement) and click Set Server.

Use the <ModelQuery> text from the exported .imx file as a reference
for the remaining fields.

If the original query references a single date, use the same date for
both Start Date and End Date.

For more information, see “View SAS Strategy Management Data in SAS
Bl Dashboard” in the SAS Strategy Management: User’s Guide and
“Indicator Data” in the SAS Bl Dashboard 4.31: User's Guide, Second
Edition. Both books are available at http://support.sas.com/
documentation/onlinedoc.

e When you save the query, use the same location as the original .imx file
(overwriting the original).

Modify Indicator Definitions

If your migration included dashboards (for SAS Bl Dashboard) that use the SAS
Strategy Management data provider, you might need to modify the indicator
definitions for those dashboards.

To modify an indicator definition:

1

Log on to the Dashboard Builder:

http://server:port/SASBIDashboard
Click Manage Dashboards.

In the Library view of the Objects pane, navigate to the .idx file, which is in
the Products » Bl Dashboard 4.3 » IndicatorDefinitions folder.

Double-click the file to open it in the workspace.

In the General area of the Properties pane, inspect the indicator data
selection. If it points to an indicator definition that you re-created in “Re-
Create Indicator Data Definitions for Dashboards” on page 32, proceed with
the next step.

Otherwise, this indicator does not use the SAS Strategy Management data
provider. Close the indicator definition and skip the remaining steps.

In the Properties pane, click the Set up indicator links button.
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7 If the Link type is External Link and the Link path is empty, change the
Link type to None and click OK.

8 Save the indicator definition.

Repeat these steps for each .idx file.

For more information about indicator definitions, see “Defining Indicators” in the
SAS Bl Dashboard: User's Guide.

Validate the Installation

After you perform the post-migration tasks, validate the installation:

1 Perform the post-configuration tasks that are described in “Performing Post-
Configuration Steps” in the SAS Strategy Management: System
Administration Guide.

CAUTION! Do not install the sample data!

2 Perform the validation tasks that are described in the Instructions.html file on
the middle tier.

3 Check for content that you know is present in the source SAS configuration.

Note: Some migrated content can or should be deleted. See Chapter 25,
“Changes in Version 5.6,” on page 111.

You can also run the authorization differences reports. Those reports are
described in the “Performing Post-migration Tasks” chapter of the SAS
Intelligence Platform: 9.1.3 to 9.2 Migration Guide. These reports identify
differences in access to libraries, tables, folders, OLAP schemas, and cubes
between the source and target SAS installations. See also What's New in SAS
9.2 Intelligence Platform and What's New in SAS Information Delivery Portal.
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Required Information to Read

Make sure that you read and complete all of parts of this migration guide
required by your current installation.

Table 6.1 Parts to Read When Migrating to SAS Strategy Management 5.6 on SAS 9.4

Current Installation Read and Complete

SAS Strategy Management 1 Migrating from SAS 9.1.3 to SAS 9.2 (Part 1)
2.40n SAS 9.1.3
2 Migrating from SAS 9.2 to SAS 9.4 (Part 2)

SAS Strategy Management Migrating from SAS 9.2 to SAS 9.4 (Part 2)
5.1 0n SAS 9.2

SAS Strategy Management
5.20n SAS 9.2

SAS Strategy Management Migrating from SAS 9.3 to SAS 9.4 (Part 3)
5.3 0n SAS 9.3

SAS Strategy Management
5.4 on SAS 9.3

SAS Strategy Management Migrating from SAS Strategy Management 5.5 to
5.50n SAS 94 Version 5.6 on SAS 9.4 (Part 4)

SAS Strategy Management Fully Promoting a SAS Strategy Management 5.6
5.6 on SAS 9.4 Installation to Another System (Part 5)

Be aware of the following notes and restrictions:

You cannot use the SAS Migration Utility and the Software Deployment
Wizard to migrate the SAS Intelligence Platform and then rerun the same
software to migrate SAS Strategy Management later in the same deployment
configuration.

If you are installing new products in addition to migrating old ones, first
complete the migration of the old installation. Then install the new products.
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Note: All documentation referred to in this part are listed in “Recommended
Reading” on page xvii.
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Important Assumptions

This chapter is written with the following assumptions:

You have prepared for a standard installation (such as installing required
third-party applications, planning which tiers are going to be installed on
which systems, and so on).

See the “Pre-Installation Steps” in the Installation Instructions for Release 5.6
of SAS Strategy Management. For migration-specific information about
external accounts, see “Create Operating System Accounts” on page 39.

You have prepared a software depot and an installation plan file.

Create Operating System Accounts

Required External Accounts

Create the required external accounts in the operating system for the primary
users, as listed in your pre-installation checklist. External accounts are defined
outside the metadata repository (for example, in the operating system).

When you perform an installation with migration from SAS 9.2, you are given the
option of using the new SAS 9.3 internal accounts. This is the preferred option.
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The following table summarizes the required external accounts and the
differences between SAS 9.2 and SAS 9.4.

Table 7.1 Required External User Accounts

External Account (SAS 9.2) External Account (SAS 9.4) Example (SAS 9.4)

SAS Installer SAS Installer domain\installer-ID

SAS Spawned Servers account SAS Spawned Servers account domain\sassrv

SAS First User SAS First User domain\sasdemo
Note:

The domain is not used for UNIX accounts.

The sasdemo account is optional. If you include this identity, it must refer to
an external account.

For more information about the account that you must use for installation with
migration, see “The SAS Installer Account” on page 40.

Optional External Accounts

The following external accounts are required only if you do not use the internal-
account option:

Table 7.2 Optional External User Accounts

External Account (SAS 9.2) External Account (SAS 9.4) Example (SAS 9.4)
SAS Administrator SAS Administrator domain\sasadm
SAS Trusted User SAS Trusted User domain\sastrust

Note: The domain is not used for UNIX accounts.

The SAS Installer Account

The SAS Installer account must be the same account that was used to install
SAS 9.2. It must have a corresponding metadata identity, with membership in
the Administrators group:

On Windows, this user must be a member of the Administrators group in the
operating system.

On UNIX, this user's profile must be the same as the SAS 9.2 profile.

Note: On UNIX, verify that the link-editor for object files, Id, is in the SAS
installer's path.
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Perform Checks Before Running the SAS
Migration Utility

On a single-tier system, perform all the pre-migration checks listed. On a multi-
tier system, perform the pre-migration checks on the specified systems.

Install the SAS Migration Utility 9.2

The SAS Migration Utility is a tool that packages content from the SAS 9.2
installation so that the content can be migrated to a new SAS 9.4 installation.
For more information about the SAS Migration Utility, see SAS 9.4 Intelligence
Platform: Migration Guide.

To install the SAS Migration Utility on Windows:

1 Locate the directory named sassoftwareDepot\utilities\smu92, where
SASSoftwareDepot is the directory where you downloaded the SAS Software
Depot.

This directory contains the smu92 executable files for 32-bit and 64-bit
Microsoft Windows operating systems, and UNIX operating systems; the
smu.properties.template file; and possibly other files and directories.

2 Copy the contents of the \utilities\smu92 directory to a new directory on
each of the systems in your SAS 9.2 installation. For example, create c:
\Program Files\SAS\SASMigrationUtility\9.2 and copy the files
there.

On UNIX, use FTP to send the files from the depot to a new directory on each of
the systems in your SAS 9.2 installation.

Run the SAS Migration Utility

Before you run the SAS Migration Utility, create a shared directory on the
network that is available to all of the systems in the installation. This directory
becomes the SAS Migration Utility migration package directory. All SAS
Migration Utility output from all systems is stored in this directory.

Then perform the following steps on each system that you want to migrate.
Begin with the system that is running the SAS 9.2 metadata server:

1 Navigate to the directory where you copied the contents of the \utilities
\smu92 depot directory.

2 Copy the smu.properties.template file to smu.properties.

3 Edit the smu.properties file with a text editor.
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Property

SMU.Output.Dir

SMU.password

SMU.SASROOQOT

SMU.spmmidtier.scorec
ard.ear.dir

SMU.webinfpltfm.dbms.
userid

SMU.webinfpltfm.dbms.
password

SMU.data.dbms.admin.
userid

SMU.data.dbms.admin.
passwd

Note: The smu.properties file is in the Java properties file format. The
following format rules are most important to apply when you are editing the
smu.properties file:

Lines that begin with the # character are comments and have no effect.

Backslash characters (\) must be doubled. For example, C:\\Program
Files\\SAS.

Review the entire smu.properties file and change property settings as
necessary.

The comments in the file explain each property that must be set. This table
explains some specific properties:

Description

This property contains the path to the SAS Migration Utility migration package
directory.

Enter the path to the shared directory that you created in step 1.

The smu.properties comments state that the SMU.password property value must be
encoded in the {sas001} format using the PWENCODE procedure. However, a
plain-text password is also accepted. If you choose to specify a plain-text password,
then for security purposes, erase this password immediately after you run the SAS
Migration Utility.

For systems on which SAS is installed, enter the path to the ' sasrooT directory.
For example, enter one of the following:

SMU. SASROOT=C: \\Program Files\\SAS\\SAS 9.2
SMU.SASROOT=/usr/local/SAS/SAS 9.2

On a middle-tier system, comment out this property.

This property must be set only for sites with SAS Solutions Services, Versions 5.1
and 5.2, and IBM WebSphere 7 on AlX.

Path to the deployed EAR file for SAS Strategic Performance Management:
WebSphere-install-dir/profiles/profile-name/installedApps/
network-cell-name/SAS Strategic Performance Management.ear

WebSphere-install-diris the path to the IBM WebSphere root installation
directory (such as /usr/IBM/WebSphere/AppServer).

profile-name is the name of the application server profile, such as Appsrvo1l.
network cell name is the cell name of the deployment manager node.

If the installation uses SAS Shared Services, or if you want to migrate alerts and
comments from SAS 9.2 to SAS 9.4, enter the user ID and password that you used
for the platform migration. For more information, see SAS 9.4 Intelligence Platform:
Migration Guide.

Enter the user ID and password that you used to install the MySQL database for
9.2.

Complete the applicable step:
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For Windows Open a command window in the directory in which you
installed the SAS Migration Utility and submit the following
command:

For 32-bit Windows: smu92 32.exe -properties
"full path to SMU install directory
\smu.properties" —replace

For 64-bit Windows: smu92 x64.exe -properties
"full path to SMU install directory
\smu.properties" —replace

Note: In the previous commands,

full_path_to_SMU _install_directory\smu.properties must be
enclosed in double quotation marks only if there is a space in
the pathname.

Note: You must specify the full path to the smu.properties file
in the -PROPERTIES option, even though the smu.properties
file is in the current directory (the same directory as the
smu.exe file). Because smu.exe is actually a self-extracting
archive, it extracts the complete program into a separate
temporary directory and runs it from there.

After a few seconds, a second command window appears with
the SAS Migration Utility console output.

For UNIX Submit the following command (line break added for
readability):
./smu92.sh -- -outputdir /usr/local/SAS/smupackage

-properties /usr/local/SAS/smu/smu.properties

Note: The output directory should not be the same as the
SAS Migration Utility installation directory.

6 Wait for the SAS Migration Utility to finish running.

Check the output as described in “Check the SAS Migration Utility Migration
Package” on page 43. For additional troubleshooting help, see “Errors
Running the SAS Migration Utility” on page 129.

Check the SAS Migration Utility Migration

Package

In the previous section, you set the SMU.Output.Dir property in the
smu.properties file to point to the SAS Migration Utility migration package
directory, the directory under which all migrated content is stored.

There is a subdirectory in the SAS Migration Utility migration package directory
named after each system on which you run SAS Migration Utility. Inside this
subdirectory are many other subdirectories. Each subdirectory contains backed-
up content from a particular SAS product. (Some directories might be empty.)

To check the SAS Migration Utility migration package:
1 After smu92_x64.exe finishes running, check the final few lines of output in

the command window to determine whether the SAS Migration Utility
produced error messages.



44 Chapter 7 / Preliminary Tasks

2

If the SAS Migration Utility produced error messages, take these steps:

View the migrate.log file in the system's subdirectory inside the SAS
Migration Utility migration package directory to determine the cause of the
error.

Look for and correct any remaining errors. If you have made corrections,
rerun the SAS Migration Utility with the -replace option.

Review the migration status messages for the products:

In the subdirectory named AnalysisReport, open the FullReport.html file
and review the messages.

There are migration status messages for each product. This report
indicates whether you must upgrade any products or install patches
before migration can be completed.

Run the SAS Migration Utility again after you install any patches.
Look for and correct any remaining error messages before you continue.

Examine all warning messages.

Note: Warning messages are for informational purposes and are
expected on most systems. For example, a warning message appears in
the Analysis Report for each data directory found in metadata that exists
outside of the SAS Configuration directory. If these data directories are
needed in the SAS 9.4 installation, migrate them manually.

Perform these additional checks to verify that data has been backed up
correctly:

Note: On the middle tier, ignore these steps.

In the metadatasrv subdirectory, verify the existence of these
subdirectories: MetadataRepositories and rposmgr.

In the MetadataRepositories subdirectory, verify the existence of one
subdirectory for each metadata repository.

In the spmdatatier subdirectory, verify the existence of an sQL
subdirectory that contains two files named spm.sql and sassdm.sq|l.

Repeat for Each System

Repeat the steps in “Run the SAS Migration Utility” on page 41 and “Check the
SAS Migration Utility Migration Package” on page 43 for every other system in
this installation (other than client systems).

Note: The FullReport.html file shows a failure (X.) for the SAS Metadata Server
Product when the smu.exe is run on any tier other than the metadata server
system.
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Read the instructions in this chapter. Then follow the installation steps in the
Installation Instructions for Release 5.6 of SAS Strategy Management.

Note: If you are migrating content from a SAS 9.1.3 system that has SAS
Strategy Management 2.4 content, you must first migrate that system to an
intermediate installation of SAS 9.2 with SAS Strategy Management 5.2. (See
Part 1.)

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.2 system that
has SAS Strategy Management Version 5.1 or 5.2 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
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is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

3. Perform the Post-Migration Tasks

Perform the post-migration tasks as described in “Part 6. Post Process Tasks.”
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For multi-tier installations, read the instructions in this chapter before you install
SAS Strategy Management. Then follow the installation steps in the Installation

Instructions for Release 5.6 of SAS Strategy Management.

Separate Metadata Tier Installation
If the data tier and metadata tier are on the same system, go to “Data Tier
Installation on the Target System” on page 48.

Otherwise, complete the following steps:

1 Run the Software Deployment Wizard on the metadata tier first.

Select both Install SAS Software and Configure SAS Software as the
deployment type.

2 If you are performing a migration installation, select Perform migration
when the Migration Information page appears.

3 After you complete the installation and configuration of the metadata tier, go

to “Data Tier Installation on the Target System” on page 48.
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Data Tier Installation on the Target System

Overview

Complete the following installation and configuration steps for installation and
migration on the data tier (the system on which you installed the MySQL Server)
and on which you plan to install the SAS Strategy Management data-tier
software.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.2 system that
has SAS Strategy Management Version 5.1 or 5.2 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.
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2. Perform the Instructions.html Tasks
Follow the steps in the Instructions.html file.

Next, go to “Installation on Additional Tiers” on page 49.

Installation on Additional Tiers

Complete the following steps on every other tier (excluding client systems).

1. Run the SAS Deployment Wizard
Run the SAS Deployment Wizard.

Deployment type: Select both Install SAS Software and Configure SAS
Software.

Perform migration: Select Perform migration when the Migration
Information page appears.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

Post-Migration

After you install and configure all the systems (other than client systems),
perform the post-migration tasks as described in “Part 6. Post Process Tasks.”
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Required Information to Read

Table 10.1 Parts to Read When Migrating to SAS Strategy Management 5.6 on SAS
9.4

Current Installation Read and Complete

SAS Strategy Management 1 Migrating from SAS 9.1.3 to SAS 9.2 (Part 1)

2.40n SAS 9.1.3
2 Migrating from SAS 9.2 to SAS 9.4 (Part 2)

SAS Strategy Management Migrating from SAS 9.2 to SAS 9.4 (Part 2)
5.1 0on SAS 9.2

SAS Strategy Management
5.20n SAS 9.2

SAS Strategy Management Migrating from SAS 9.3 to SAS 9.4 (Part 3)
5.3 0on SAS 9.3

SAS Strategy Management
5.4 on SAS 9.3

SAS Strategy Management Migrating from SAS Strategy Management 5.5 to
550n SAS 9.4 Version 5.6 on SAS 9.4 (Part 4)

SAS Strategy Management Fully Promoting a SAS Strategy Management 5.6
5.6 on SAS 9.4 Installation to Another System (Part 5)

Be aware of the following notes and restrictions:

You cannot use the SAS Migration Utility and the Software Deployment
Wizard to migrate the SAS Intelligence Platform and then rerun the same
software to migrate SAS Strategy Management later in the same deployment
configuration.

When migrating from SAS 9.3 to SAS 9.4, update-in-place is not supported.
The best recommended practice is to migrate the existing product
deployment to SAS 9.4. Then, install additional products. For detailed
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information, see Appendix 4, “Managing Your SAS Deployment” in SAS
Intelligence Platform: Installation and Configuration Guide.

Note: All documentation referred to in this part are listed in “Recommended
Reading” on page xvii.

Installing Version 5.6

If your installation is SAS Strategy Management, Versions 5.1, 5.2, 5.3, 5.4, or
5.5, you can install Version 5.6 on SAS 9.4 by migrating from your earlier
installation to a Version 5.6 installation. A migrated installation runs the SAS
Migration Utility on each tier of the installation to extract content and metadata
and create a migration package. You use this package later to supply content
during the installation and configuration in a new deployment. The new
deployment might have additional products installed and configured in it that did
not exist in the previous installation. The migrated installation enables your users
to continue to use the existing installation of SAS Strategy Management while
you install Version 5.6.

When your installation is complete, see Chapter 25, “Changes in Version 5.6,”
on page 111 to learn about changes in Version 5.6 from previous versions of
SAS Strategy Management.
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Important Assumptions

This document is written with the following assumptions:

You have prepared for a standard installation (such as installing required
third-party applications, planning which tiers are going to be installed on
which systems, and so on).

See the “Pre-Installation Steps” in the Installation Instructions for Release 5.6
of SAS Strategy Management. For migration-specific information about
external accounts, see “Create Operating System Accounts” on page 55.

You have prepared a software depot and an installation plan file.

Create Operating System Accounts

Required External Accounts

Create the required external accounts in the operating system for the primary
users, as listed in your pre-installation checklist. External accounts are defined
outside the metadata repository (for example, in the operating system).

The following table summarizes the required external accounts for SAS 9.4.
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Table 11.1 Required External User Accounts for SAS 9.4

External Account Example

SAS Installer domain\installer-1D
SAS Spawned Servers account domain\sassrv
SAS First User domain\sasdemo
Note:

The domain is not used for UNIX accounts.

The sasdemo account is optional. If you include this identity, it must refer to
an external account.

For more information about the account that you must use for installation with
migration, see “The SAS Installer Account” on page 56.

Optional External Accounts

The following external accounts are required only if you do not use the internal-
account option:

Table 11.2 Optional External User Accounts for SAS 9.4

External Account Example
SAS Administrator domain\sasadm
SAS Trusted User domain\sastrust

Note: The domain is not used for UNIX accounts.

The SAS Installer Account

The SAS Installer account must have a corresponding metadata identity, with
membership in the Administrators group.

Windows: This user must be a member of the Administrators group in the
operating system.

UNIX: This user's profile must be the same as the SAS 9.3 profile.

Note: On UNIX, verify that the link-editor for object files, Id, is in the SAS
installer's path.
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Perform Checks Before Running the SAS
Migration Utility

On a single-tier system, perform all the pre-migration checks listed. On a multi-
tier system, perform the pre-migration checks on the specified systems.

Install the SAS Migration Utility 9.3

The SAS Migration Utility is a tool that packages content from the SAS 9.3
installation so that the content can be migrated to a new SAS 9.4 installation.
For more information about the SAS Migration Utility, see SAS 9.3 Intelligence
Platform: Migration Guide.

To install the SAS Migration Utility:

1 Locate the directory named sassoftwareDepot\utilities\smu93, where
SASSoftwareDepot is the directory where you downloaded the SAS Software
Depot.

This directory contains the smu93 executable file for 64-bit Microsoft
Windows operating systems and UNIX operating systems; the
smu.properties.template file; and possibly other files and directories.

2 Copy the contents of the sassoftwareDepot\utilities\smu93 directory
to a new directory on each of the systems in your SAS 9.3 installation. For
example, create C: \Program Files\SAS\SASMigrationUtility\9.3
and copy the files there.

Note: On UNIX, use FTP to send the files from the depot to a new directory
on each of the systems in your SAS 9.3 installation.

Run the SAS Migration Utility

Before you run the SAS Migration Utility, create a shared directory on the
network that is available to all of the systems in the installation. This directory
becomes the SAS Migration Utility migration package directory. All SAS
Migration Utility output from all systems is stored in this directory.

Then perform the following steps on each system that requires migration. Begin
with the system that is running the SAS 9.3 metadata server:

1 Navigate to the directory where you copied the contents of the
SASSoftwareDepot\utilities\smu93, where SASSoftwareDepot is the
directory where you downloaded the SAS Software Depot.

2 Copy the smu.properties.template file to smu.properties.

3 Edit the smu.properties file with a text editor.
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Property

SMU.Output.Dir

SMU.password

SMU.SASROOQOT

SMU.spmmidtier.score
card.ear.dir

SMU.webinfpltfm.dbm
s.userid

SMU.webinfpltfm.dbm
s.password

SMU.data.dbms.admi
n.userid

SMU.data.dbms.admi
n.passwd

Note: The smu.properties file is in the Java properties file format. The
following format rules are most important to apply when you are editing the
smu.properties file:

Lines that begin with the # character are comments and have no effect.

Backslash characters (\) must be doubled. For example, C:\\Program
Files\\SAS.

Review the entire smu.properties file and change property settings as
necessary.

The comments in the file explain each property that must be set. This table
explains some specific properties:

Description

This property contains the path to the SAS Migration Utility migration package
directory.

Enter the path to the shared directory that you created in step 1.

The smu.properties comments state that the SMU.password property value must be
encoded in the {sas001} format using the PWENCODE procedure. However, a plain-
text password is also accepted. If you choose to specify a plain-text password, then
for security purposes, erase this password immediately after you run the SAS
Migration Utility.

For systems on which SAS is installed, enter the path to the ' sasrooT directory. For
example, enter one of the following:

SMU. SASROOT=C: \\Program Files\\SAS\\SAS 9.3
SMU. SASROOT=/usr/local/SAS/SAS 9.3

On a middle-tier system, comment out this property.

This property must be set only for sites with SAS Solutions Services.

Path to the deployed EAR file for SAS Strategic Performance Management:
WebSphere-install-dir/profiles/profile-name/installedApps/network-
cell-name/SAS Strategic Performance Management.ear

WebSphere-install-dir is the path to the IBM WebSphere root installation
directory (such as /usr/IBM/WebSphere/AppServer).

profile-name is the name of the application server profile, such as AppsSrvo01.

network cell name is the cell name of the deployment manager node.

If the installation uses SAS Shared Services and you want to migrate alerts and
comments, enter the user ID and password that you used for the platform migration.
For more information, see SAS 9.3 Intelligence Platform: Migration Guide.

Enter the user ID and password that you used to install the MySQL database for 9.3.

5 Complete the applicable step:
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For Windows Open a command window in the directory in which you
installed the SAS Migration Utility and submit the following
command:

smu93 x64.exe -properties
"full path to SMU install directory
\smu.properties" —replace

Note: In the previous commands,
full_path_to_SMU_install_directory\smu.properties must be
enclosed in double quotation marks only if there is a space in
the pathname.

Note: You must specify the full path to the smu.properties file
in the -PROPERTIES option, even though the smu.properties
file is in the current directory (the same directory as the
smu.exe file). Because smu.exe is actually a self-extracting
archive, it extracts the complete program into a separate
temporary directory and runs it from there.

After a few seconds, a second command window appears with
the SAS Migration Utility console output.

For UNIX Submit the following command (line break added for
readability):
./smu93.sh -- -outputdir /usr/local/SAS/smupackage

-properties /usr/local/SAS/smu/smu.properties

Note: The output directory should not be the same as the
SAS Migration Utility installation directory.

6 Wait for the SAS Migration Utility to finish running.

Check the output as described in “Check the SAS Migration Utility Migration
Package” on page 59. For additional troubleshooting help, see “Errors
Running the SAS Migration Utility” on page 129.

Check the SAS Migration Utility Migration

Package

In the previous section, you set the SMU.Output.Dir property in the
smu.properties file to point to the SAS Migration Utility migration package
directory, the directory under which all migrated content is stored.

There is a subdirectory in the SAS Migration Utility migration package directory
named after each system on which you run SAS Migration Utility. Inside this
subdirectory are many other subdirectories. Each subdirectory contains backed-
up content from a particular SAS product. (Some directories might be empty.)

To check the SAS Migration Utility migration package:

1 After smu93_x64.exe finishes running, check the final few lines of output in
the command window to determine whether the SAS Migration Utility
produced error messages.

2 If the SAS Migration Utility produced error messages, take these steps:
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View the migrate.log file in the system's subdirectory inside the SAS
Migration Utility migration package directory to determine the cause of the
error.

Look for and correct any remaining errors. If you have made corrections,
rerun the SAS Migration Utility with the -replace option.

3 Review the migration status messages for the products:

In the subdirectory named AnalysisReport, open the FullReport.html file
and review the messages.

There are migration status messages for each product. This report
indicates whether you must upgrade any products or install patches
before migration can be completed.

Run the SAS Migration Utility again after you install any patches.
Look for and correct any remaining error messages before you continue.

Examine all warning messages.

Note: Warning messages are for informational purposes and are
expected on most systems. For example, a warning message appears in
the Analysis Report for each data directory found in metadata that exists
outside of the SAS Configuration directory. If these data directories are
needed in the SAS 9.4 installation, migrate them manually.

4 Perform these additional checks to verify that data has been backed up
correctly:

Note: On the middle tier, ignore these steps.

In the metadatasrv subdirectory, verify the existence of these
subdirectories: MetadataRepositories and rposmgr.

In the MetadataRepositories subdirectory, verify the existence of one
subdirectory for each metadata repository.

In the spmdatatier subdirectory, verify the existence of an sQL
subdirectory that contains the file named spm.sql and might contain
sassdm.sql.

Repeat for Each System

Repeat the steps in “Run the SAS Migration Utility” on page 57 and “Check the
SAS Migration Utility Migration Package” on page 59 for every other system in
this installation (other than client systems).

Note: The FullReport.html file shows a failure (X-) for the SAS Metadata Server
Product when the smu.exe is run on any tier other than the metadata server
system.
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Overview

Read the instructions in this chapter. Then follow the installation steps in the
Installation Instructions for Release 5.6 of SAS Strategy Management.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.3 system that
has SAS Strategy Management Version 5.3 or 5.4 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
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given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

SAS Enterprise Guide mode or SAS Add-in for Microsoft Office mode: It
is recommended that you select 64-bit Native Mode.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

3. Perform the Post-Migration Tasks

Perform the post-migration tasks as described in “Part 6. Post Process Tasks.”
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For multi-tier installations, read the instructions in this chapter before you install
SAS Strategy Management. Then follow the installation steps in the Installation

Instructions for Release 5.6 of SAS Strategy Management.

Separate Metadata Tier Installation
If the data tier and metadata tier are on the same system, go to “Data Tier
Installation on the Target System” on page 64.

Otherwise, complete the following steps:

1 Run the Software Deployment Wizard on the metadata tier first.

Select both Install SAS Software and Configure SAS Software as the
deployment type.

2 If you are performing a migration installation, select Perform migration
when the Migration Information page appears.

3 After you complete the installation and configuration of the metadata tier, go

to “Data Tier Installation on the Target System” on page 64.
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Data Tier Installation on the Target System

Overview

Complete the following installation and configuration steps for installation and
migration on the data tier (the system on which you installed the MySQL Server)
and on which you plan to install the SAS Strategy Management data-tier
software.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.3 system that
has SAS Strategy Management Version 5.3 or 5.4 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

SAS Enterprise Guide mode or SAS Add-in for Microsoft Office mode: It
is recommended that you select 64-bit Native Mode.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.
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2. Perform the Instructions.html Tasks
Follow the steps in the Instructions.html file.

Next, go to “Installation on Additional Tiers” on page 65.

Installation on Additional Tiers

Complete the following steps on every other tier (excluding client systems).

1. Run the SAS Deployment Wizard
Run the SAS Deployment Wizard.

Deployment type: Select both Install SAS Software and Configure SAS
Software.

Perform migration: When the Migration Information page appears, select
Perform migration.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

Post-Migration

After you install and configure all the systems (other than client systems),
perform the post-migration tasks as described in “Part 6. Post Process Tasks.”
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Choosing How to Migrate From Version 5.5
to 5.6

If you have a SAS Strategy Management 5.5 installation on SAS 9.4, you can
install Version 5.6 in one of the following ways:

by migrating from your Version 5.5 installation to a Version 5.6 installation.

A migrated installation runs the SAS Migration Utility on each tier of the
installation to extract content and metadata and create a migration package.
You use this package later to supply content during the installation and
configuration in a new deployment. The new deployment might have
additional products installed and configured in it that did not exist in the
previous installation. The migrated installation enables your users to continue
to use SAS Strategy Management 5.5 while you install Version 5.6.

Note: When you follow these steps, you rely on the SAS Software Depot to
accomplish the migration. If the version of SAS Strategy Management in the
SAS Software Depot does not match the version in your installation (for
example, Version 5.6 instead of Version 5.61), the software installation can
vary and is not a perfect copy of the source installation of SAS Strategy
Management.

To perform a migrated installation, see the following chapters:
Chapter 15, “Preliminary Tasks,” on page 71
Chapter 16, “Single-Tier Installation,” on page 75
Chapter 17, “Multi-Tier Installation,” on page 77

by upgrading your Version 5.5 installation in its current location to a Version
5.6 installation.

An upgrade-in-place method installs SAS Strategy Management 5.6 by
copying the product files directly over the SAS Strategy Management 5.5
installation. The upgrade-in-place method has the advantage of being faster
than a migrated installation. However, because the Version 5.6 installation
overlays the files of the Version 5.5 installation, the SAS Strategy
Management installation is unavailable for users during the upgrade-in-place
process. Also, it is strongly recommended that you create full backups of the
systems involved before this process starts.
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To perform an upgrade-in-place installation, see Chapter 18, “Upgrade-In-
Place Installation,” on page 81.

When your installation is complete, see Chapter 25, “Changes in Version 5.6,”
on page 111to learn about changes in Version 5.6 from previous versions of
SAS Strategy Management.

Note: If your current installation is on:

SAS 9.1.3 and you want to migrate to SAS 9.4, go to “Part 1. Migrating from
SAS 9.1.3 to SAS 9.2.” Then, go to “Part 2. Migrating from SAS 9.2 to SAS
9.4

SAS 9.2 and you want to migrate to SAS 9.4, go to “Part 2. Migrating from
SAS 9.2to SAS 9.4

SAS 9.3 and you want to migrate to SAS 9.4, go to “Part 3. Migrating from
SAS 9.3to SAS 9.4
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Install the SAS Migration Utility 9.4

The SAS Migration Utility is a tool that packages content from the SAS 9.4
installation so that the content can be migrated to a new SAS 9.4 installation.
For more information about the SAS Migration Utility, see SAS 9.4 Intelligence
Platform: Migration Guide.

To install the SAS Migration Utility on Windows:

1 Locate the directory named sassoftwareDepot\utilities\smu94, where
SASSoftwareDepot is the directory where you downloaded the SAS Software
Depot.

The sassoftwareDepot\utilities\smu94 directory contains the smu94
executable file 64-bit Microsoft Windows operating systems, and UNIX
operating systems; the smu.properties.template file; and possibly other files
and directories.

2 Copy the contents of the sassoftwareDepot\utilities\smu94 directory
to a new directory on each of the systems in your SAS 9.4 installation. For
example, create C: \Program Files\SAS\SASMigrationUtility\9.4
and copy the files there.

On UNIX, use FTP to send the files from the depot to a new directory on each of
the systems in your SAS 9.4 installation.

Run the SAS Migration Utility

Before you run the SAS Migration Utility, create a shared directory on the
network that is available to all of the systems in the installation. This directory
becomes the SAS Migration Utility migration package directory. All SAS
Migration Utility output from all systems is stored in this directory.
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Property

SMU.Output.Dir

SMU.password

SMU.SASROOQOT

Then perform the following steps on each system that you want to migrate.
Begin with the system that is running the SAS 9.4 metadata server:

1 Navigate to the directory where you copied the contents of the
SASSoftwareDepot\utilities\smu94 directory, where
SASSoftwareDepot is the directory where you downloaded the SAS Software
Depot.

2 Copy the smu.properties.template file to smu.properties.

3 Edit the smu.properties file with a text editor.

Note: The smu.properties file is in the Java properties file format. The
following format rules are most important to apply when you are editing the
smu.properties file:

Lines that begin with the # character are comments and have no effect.

Backslash characters (\) must be doubled or typed as single forward
slashes. For example, C:\\Program Files\\SAS and C:/Program
Files/SAS.

4 Review the entire smu.properties file and change property settings as
necessary.

The comments in the file explain each property that must be set. This table
explains some specific properties:

Description

This property contains the path to the SAS Migration Utility migration
package directory.

Enter the path to the shared directory that you created in step 1.

The smu.properties comments state that the SMU.password property
value must be encoded in the {sas001} format using the PWENCODE
procedure. However, a plain-text password is also accepted. If you
choose to specify a plain-text password, then, for security purposes,
erase this password immediately after you run the SAS Migration Utility.

For systems on which SAS is installed, enter the path to the 1 sasrooT
directory. For example, enter one of the following:

SMU.SASROOT=C: \\Program Files\\SAS\\SAS 9.4
or
SMU. SASROOT:/USI/local/SAS/SAS_9 .4

On a middle-tier system, comment out this property.

SMU.webinfpltfm.dbms.userid Enter the user ID and password that are required for the platform

SMU.webinfpltfm.dbms.password

migration. Typically, the user ID is that of the database administrative
owner (dbmsowner). This user ID is also required for SAS Strategy
Management migration. For more information, see SAS 9.4 Intelligence
Platform: Migration Guide.

5 Complete the applicable step:
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Open a command window in the directory in which you
installed the SAS Migration Utility and submit the following
command:

smu94 x64.exe -properties
"full path to SMU install directory
\smu.properties" —replace

Note: In the previous commands,
full_path_to_SMU_install_directory\smu.properties must be
enclosed in double quotation marks only if there is a space in
the pathname.

Note: You must specify the full path to the smu.properties file
in the -PROPERTIES option, even though the smu.properties
file is in the current directory (the same directory as the
smu.exe file). Because smu.exe is actually a self-extracting
archive, it extracts the complete program into a separate
temporary directory and runs it from there.

After a few seconds, a second command window appears with
the SAS Migration Utility console output.

Submit the following command (line break added for
readability):

./smu94.sh -- -outputdir /usr/local/SAS/smupackage
-properties /usr/local/SAS/smu/smu.properties

Note: The output directory should not be the same as the
SAS Migration Utility installation directory.

6 Wait for the SAS Migration Utility to finish running.

Check the output as described in “Check the SAS Migration Utility Migration
Package” on page 73.

Check the SAS Migration Utility Migration

Package

In the previous section, you set the SMU.Output.Dir property in the
smu.properties file to point to the SAS Migration Utility migration package
directory, the directory under which all migrated content is stored.

There is a subdirectory in the SAS Migration Utility migration package directory
named after each system on which you run SAS Migration Utility. Inside this
subdirectory are many other subdirectories. Each subdirectory contains backed-
up content from a particular SAS product. (Some directories might be empty.)

To check the SAS Migration Utility migration package:

1 After smu94 x64.exe finishes running, check the final few lines of output in
the command window to determine whether the SAS Migration Utility
produced error messages.

If the SAS Migration Utility produced error messages, take these steps:

a View the migrate.log file in the system's subdirectory inside the SAS

Migration Utility migration package directory to determine the cause of the

error.
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b

Look for and correct any remaining errors. If you have made corrections,
rerun the SAS Migration Utility with the -replace option.

3 Review the migration status messages for the products:

In the subdirectory named AnalysisReport, open the FullReport.html file
and review the messages.

There are migration status messages for each product. This report
indicates whether you must upgrade any products or install patches
before migration can be completed.

Run the SAS Migration Utility again after you install any patches.
Look for and correct any remaining error messages before you continue.

Examine all warning messages.

Note: Warning messages are for informational purposes and are
expected on most systems. For example, a warning message appears in
the Analysis Report for each data directory found in metadata that exists
outside of the SAS Configuration directory. If these data directories are
needed in the SAS 9.4 installation, migrate them manually.

4 Perform these additional checks to verify that data has been backed up
correctly:

Note: On the middle tier, ignore these steps.

In the metadatasrv subdirectory, verify the existence of these
subdirectories: MetadataRepositories and rposmgr.

In the MetadataRepositories subdirectory, verify the existence of one
subdirectory for each metadata repository.

In the spmdatatier subdirectory, verify the existence of a sQL
subdirectory that contains the file spm.sql.

Repeat for Each System

Repeat the steps in “Run the SAS Migration Utility” on page 71 and “Check the
SAS Migration Utility Migration Package” on page 73 for every other system in
this installation (other than client systems).
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Overview

Read the instructions in this chapter. Then follow the installation steps in the
Installation Instructions for Release 5.6 of SAS Strategy Management.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.4 system that
has SAS Strategy Management Version 5.5 or 5.6 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
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given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

3. Perform the Post-Migration Tasks

Perform the post-migration tasks as described in “Part 6. Post Process Tasks.”
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For multi-tier installations, read the instructions in this chapter before you install

SAS Strategy Management. Then follow the installation steps in Installation
Instructions for Release 5.6 of SAS Strategy Management.

Separate Metadata Tier Installation
If the data tier and metadata tier are on the same system, go to “Data-Tier
Installation on the Target System” on page 78.

Otherwise, complete the following steps:

1 Run the Software Deployment Wizard on the metadata tier first.

Select both Install SAS Software and Configure SAS Software as the
deployment type.

2 If you are performing a migration installation, select Perform migration
when the Migration Information page appears.

3 After you complete the installation and configuration of the metadata tier, go

to “Data-Tier Installation on the Target System” on page 78.
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Data-Tier Installation on the Target System

Overview

Complete the following installation and configuration steps for installation and
migration on the data tier (the system on which you installed the MySQL Server)
and on which you plan to install the SAS Strategy Management data-tier
software.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.4 system that
has SAS Strategy Management Version 5.5 or 5.6 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.
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2. Perform the Instructions.html Tasks
Follow the steps in the Instructions.html file.

Next, go to “Installation on Additional Tiers” on page 79.

Installation on Additional Tiers

Complete the following steps on every other tier (excluding client systems).

1. Run the SAS Deployment Wizard
Run the SAS Deployment Wizard.

Deployment type: Select both Install SAS Software and Configure SAS
Software.

Perform migration: When the Migration Information page appears, select
Perform migration.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

Post-Migration Tasks

Perform the post-migration tasks as described in “Part 6. Post Process Tasks.”

After you install and configure all the systems (other than client systems),
perform the post-migration tasks as described in “Part 6. Post Process Tasks.”
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What Is Upgrade in Place?

If you have a SAS Strategy Management 5.5 installation, you can upgrade the
installation to Version 5.6 by using the information in this chapter.

An upgrade-in-place method installs SAS Strategy Management 5.6 by copying
the product files directly over the SAS Strategy Management 5.5 installation.
The upgrade-in-place method has the advantage of being faster than a migrated
installation. However, because the Version 5.6 installation overlays the files of
the Version 5.5 installation, the SAS Strategy Management installation is
unavailable for users during the upgrade-in-place process. Also, it is strongly
recommended that you create full backups of the systems involved before this
process starts.

Requirements

You must ensure that you have read the SAS Intelligence Platform: Guide to
Software Updates. Ensure that you understand the following chapters:

“Chapter 7. Undeploying SAS Web Applications”
“Chapter 12. Installing a Software Update”

CAUTION! It is strongly recommended that you perform a full system backup
of all systems and tiers which will be affected by the upgrade. In some cases,
the backup might be the only feasible restoration option in a multi-system installation.
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Preliminary Tasks

1 Undeploy Java web applications by following the instructions in the SAS
Intelligence Platform: Guide to Software Updates, Chapter 7.

2 Read the SAS Intelligence Platform: Guide to Software Updates, “Chapter 4.
Update Operating Environments and Third-Party Software” for Java
Development Kit (JDK) and Java Runtime Environment requirements.

3 If you are upgrading a system that has been re-hosted or has had the
multicast address manually updated since the original installation, you must
edit the midtier.multicast.address property before shutting down the
metadata server.

Use SAS Metabrowse to edit the Public Notes TextStore of the Deployment
Properties — GlobalRoot SoftwareComponent to change the TextStore’s
midtier.multicast.address property value to match the current setting for the
multicast.address property value setting in the following file: SASconfig/
level/Web/Applications/RemoteServices/
environment.properties, where SASconfig is the installation directory for
SAS Configuration and /level is the directory for the installation level.

Note: You do not need to change the multicast address if you are upgrading
the SAS Strategy Management software on the SAS 9.4 platform. It is
required only if customer-supplied applications that used the feature are
deployed on the SAS 9.4 platform.

Upgrade the SAS Strategy Management
Product Files

The following procedure does not include all of the steps that you must
complete. Instead, this procedure describes steps that are specific to the SAS
Strategy Management upgrade. To review the entire upgrade procedure, follow
the instructions in the section called “Install and Configure a Software Update” in
the SAS Intelligence Platform: Guide to Software Updates.

1 Terminate all active SAS sessions, daemons, spawners, and servers and
start the SAS Deployment Wizard from your SAS Software Depot.

Note: For multi-system installations, the order of installation must be the
same order as in the original installation.

The SAS Deployment Wizard starts in Update mode on each system. The
wizard updates the product directories that are located in
SASinstallationdir/SASHOME. For example, on the data tier system in
SASinstallationdir/SASHOME/SASStrategyManagementDatatier, the
wizard adds a 5.6 directory next to the existing 5.5 directory.

After the installation deployment phase of the SAS Deployment Wizard is
completed, the SAS Deployment Wizard starts the SAS Deployment
Manager which displays the Select Configuration Directory/Level window.
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SAS Deployment Wizard [_ (O] x|
Select Configuration Directory,/Level

Select the configuration directory and the level within the configuration directory to ‘
update,

The fFollowing configuration directories were Found associsked with the SAS Home that was just updated. The 545 Deployment
Manager will be launched to update each selected configuration direckary when the Start button is clicked.

Configuration Direckaory Configuration Level
W CisasiConfio Levl
Select Al | Clear All
Help | < Back. I Stark I Cancel |

Select your configuration directory and click Start. The SAS Deployment
Manager starts.

Answer the configuration prompts displayed by the SAS Deployment
Manager. Ensure that in the SAS Solutions Services Extensions for SAS
Strategy Management window, you select Strategy Management 5.6.

When you have answered all of the configuration prompts, the SAS
Deployment Manager displays a Summary window.

Review your selections and then click Start.

When the configuration is completed, validate the upgrade by starting the
SAS Strategy Management Builder. Click Help » About. The About window
displays the following version and build date.

About This Product

SAS Strategy Management
Version: 5.06.000 ( 506000.23.0.20140219190000_d4stm56 )
Build Date: February 19, 2014 7:00:00 PM EST

Note: If you plan to install the SAS Visual Analytics Report Services, you
might want to perform additional site-specific installation validations before
proceeding.
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Migrating Version 5.6 to Another System

If you have a SAS Strategy Management 5.6 installation and you want to
migrate (copy) it to another system, you can do so by completing the steps
described in this part (Part 5) of the SAS Strategy Management 5.6: Migration
Guide. When you follow these steps, you rely on the SAS Software Depot to
accomplish the migration. If the version of SAS Strategy Management in the
SAS Software Depot does not match the version in your installation (for
example, Version 5.6 instead of Version 5.61, the software installation can vary
and is not a perfect copy of the source installation of SAS Strategy
Management.
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Install the SAS Migration Utility 9.4

The SAS Migration Utility is a tool that packages content from the SAS 9.4
installation so that the content can be migrated to a new SAS 9.4 installation.
For more information about the SAS Migration Utility, see SAS 9.4 Intelligence
Platform: Migration Guide.

To install the SAS Migration Utility on Windows:

1 Locate the directory named sassoftwareDepot\utilities\smu94, where
SASSoftwareDepot is the directory where you downloaded the SAS Software
Depot.

The sassoftwareDepot\utilities\smu94 directory contains the smu94
executable file 64-bit Microsoft Windows operating systems, and UNIX
operating systems; the smu.properties.template file; and possibly other files
and directories.

2 Copy the contents of the sassoftwareDepot\utilities\smu94 directory
to a new directory on each of the systems in your SAS 9.4 installation. For
example, create C: \Program Files\SAS\SASMigrationUtility\9.4
and copy the files there.

On UNIX, use FTP to send the files from the depot to a new directory on each of
the systems in your SAS 9.4 installation.

Run the SAS Migration Utility

Before you run the SAS Migration Utility, create a shared directory on the
network that is available to all of the systems in the installation. This directory
becomes the SAS Migration Utility migration package directory. All SAS
Migration Utility output from all systems is stored in this directory.
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Property

SMU.Output.Dir

SMU.password

SMU.SASROOQOT

Then perform the following steps on each system that you want to migrate.
Begin with the system that is running the SAS 9.4 metadata server:

1 Navigate to the directory where you copied the contents of the
SASSoftwareDepot\utilities\smu94 directory, where
SASSoftwareDepot is the directory where you downloaded the SAS Software
Depot.

2 Copy the smu.properties.template file to smu.properties.

3 Edit the smu.properties file with a text editor.

Note: The smu.properties file is in the Java properties file format. The
following format rules are most important to apply when you are editing the
smu.properties file:

Lines that begin with the # character are comments and have no effect.

Backslash characters (\) must be doubled or typed as single forward
slashes. For example, C:\\Program Files\\SAS and C:/Program
Files/SAS.

4 Review the entire smu.properties file and change property settings as
necessary.

The comments in the file explain each property that must be set. This table
explains some specific properties:

Description

This property contains the path to the SAS Migration Utility migration
package directory.

Enter the path to the shared directory that you created in step 1.

The smu.properties comments state that the SMU.password property
value must be encoded in the {sas001} format using the PWENCODE
procedure. However, a plain-text password is also accepted. If you
choose to specify a plain-text password, then, for security purposes,
erase this password immediately after you run the SAS Migration Utility.

For systems on which SAS is installed, enter the path to the 1 sasrooT
directory. For example, enter one of the following:

SMU.SASROOT=C: \\Program Files\\SAS\\SAS 9.4
or
SMU. SASROOT:/USI/local/SAS/SAS_9 .4

On a middle-tier system, comment out this property.

SMU.webinfpltfm.dbms.userid Enter the user ID and password that are required for the platform

SMU.webinfpltfm.dbms.password

migration. Typically, this user ID is that of the database administrative
owner (dbmsowner). This user ID is also required for SAS Strategy
Management migration. For more information, see SAS 9.4 Intelligence
Platform: Migration Guide.

5 Complete the applicable step:
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For UNIX

Check the SAS Migration Utility Migration Package 91

Open a command window in the directory in which you
installed the SAS Migration Utility and submit the following
command:

smu94 x64.exe -properties
"full path to SMU install directory
\smu.properties" —replace

Note: In the previous commands,
full_path_to_SMU_install_directory\smu.properties must be
enclosed in double quotation marks only if there is a space in
the pathname.

Note: You must specify the full path to the smu.properties file
in the -PROPERTIES option, even though the smu.properties
file is in the current directory (the same directory as the
smu.exe file). Because smu.exe is actually a self-extracting
archive, it extracts the complete program into a separate
temporary directory and runs it from there.

After a few seconds, a second command window appears with
the SAS Migration Utility console output.

Submit the following command (line break added for
readability):

./smu94.sh -- -outputdir /usr/local/SAS/smupackage
-properties /usr/local/SAS/smu/smu.properties

Note: The output directory should not be the same as the
SAS Migration Utility installation directory.

6 Wait for the SAS Migration Utility to finish running.

Check the output as described in “Check the SAS Migration Utility Migration
Package” on page 91.

Check the SAS Migration Utility Migration

Package

In the previous section, you set the SMU.Output.Dir property in the
smu.properties file to point to the SAS Migration Utility migration package
directory, the directory under which all migrated content is stored.

There is a subdirectory in the SAS Migration Utility migration package directory
named after each system on which you run SAS Migration Utility. Inside this
subdirectory are many other subdirectories. Each subdirectory contains backed-
up content from a particular SAS product. (Some directories might be empty.)

To check the SAS Migration Utility migration package:

1 After smu94 x64.exe finishes running, check the final few lines of output in
the command window to determine whether the SAS Migration Utility
produced error messages.

If the SAS Migration Utility produced error messages, take these steps:

a View the migrate.log file in the system's subdirectory inside the SAS

Migration Utility migration package directory to determine the cause of the

error.
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b

Look for and correct any remaining errors. If you have made corrections,
rerun the SAS Migration Utility with the -replace option.

3 Review the migration status messages for the products:

In the subdirectory named AnalysisReport, open the FullReport.html file
and review the messages.

There are migration status messages for each product. This report
indicates whether you must upgrade any products or install patches
before migration can be completed.

Run the SAS Migration Utility again after you install any patches.
Look for and correct any remaining error messages before you continue.

Examine all warning messages.

Note: Warning messages are for informational purposes and are
expected on most systems. For example, a warning message appears in
the Analysis Report for each data directory found in metadata that exists
outside of the SAS Configuration directory. If these data directories are
needed in the SAS 9.4 installation, migrate them manually.

4 Perform these additional checks to verify that data has been backed up
correctly:

Note: On the middle tier, ignore these steps.

In the metadatasrv subdirectory, verify the existence of these
subdirectories: MetadataRepositories and rposmgr.

In the MetadataRepositories subdirectory, verify the existence of one
subdirectory for each metadata repository.

In the spmdatatier subdirectory, verify the existence of a sQL
subdirectory that contains the file spm.sql.

Repeat for Each System

Repeat the steps in “Run the SAS Migration Utility” on page 89 and “Check the
SAS Migration Utility Migration Package” on page 91 for every other system in
this installation (other than client systems).
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Overview

Read the instructions in this chapter. Then follow the installation steps in the
Installation Instructions for Release 5.6 of SAS Strategy Management.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.4 system that
has SAS Strategy Management Version 5.5 or 5.6 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
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given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

3. Perform the Post-Promotion Tasks

Perform the post-promotion tasks as described in “Part 6. Post Process Tasks.”
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For multi-tier installations, read the instructions in this chapter before you install

SAS Strategy Management. Then follow the installation steps in Installation
Instructions for Release 5.6 of SAS Strategy Management.

Separate Metadata Tier Installation
If the data tier and metadata tier are on the same system, go to “Data-Tier
Installation on the Target System” on page 96.

Otherwise, complete the following steps:

1 Run the Software Deployment Wizard on the metadata tier first.

Select both Install SAS Software and Configure SAS Software as the
deployment type.

2 If you are performing a migration installation, select Perform migration
when the Migration Information page appears.

3 After you complete the installation and configuration of the metadata tier, go

to “Data-Tier Installation on the Target System” on page 96.
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Data-Tier Installation on the Target System

Overview

Complete the following installation and configuration steps for installation and
migration on the data tier (the system on which you installed the MySQL Server)
and on which you plan to install the SAS Strategy Management data-tier
software.

1. Run the SAS Deployment Wizard

Run the SAS Deployment Wizard, making the following selections:

Deployment type: Select both Install SAS Software and Configure SAS
Software as the deployment type.

Perform migration: If you are migrating content from a SAS 9.4 system that
has SAS Strategy Management Version 5.5 or 5.6 content, select Perform
Migration when the Migration Information page appears.

In the SAS Migration Utility Package Directory field, type or navigate to
the shared directory in which the SAS Migration Utility stored its output.

Refer to the following notes when you are responding to prompts in the SAS
Deployment Wizard:

Internal Accounts: It is recommended that you select Use SAS internal
accounts when appropriate on the Deployment Accounts wizard page. See
“Create Operating System Accounts” on page 39.

External accounts: When you are asked for the user name and password of
an external account, check the domain name prefix carefully to ensure that it
is correct for your site. The domain name prefix from a previously migrated
system might still be in use.

Server context: The SAS Deployment Wizard presents several pages in
which you must select the application server context. During migration, the
correct application server context might not be selected by default. Typically,
given the choice between the SAS metadata server context (SASMeta) and
SAS application server (SASApp), you should choose SASApp.

When the Deployment Summary page appears, the SAS Deployment Wizard
has finished collecting installation and configuration input. This is your last
opportunity to go back and change any information that you have provided in
previous pages before the wizard begins writing to your system. Before you
proceed with a migration, make sure that the input that you have provided to the
SAS Deployment Wizard is correct.

CAUTION! Incorrect user input such as user ID and passwords causes all or
portions of your migration to fail.

For detailed information, see the installation guides for SAS Intelligence
Platform.
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2. Perform the Instructions.html Tasks
Follow the steps in the Instructions.html file.

Next, go to “Installation on Additional Tiers” on page 97.

Installation on Additional Tiers

Complete the following steps on every other tier (excluding client systems).

1. Run the SAS Deployment Wizard
Run the SAS Deployment Wizard.

Deployment type: Select both Install SAS Software and Configure SAS
Software.

Perform migration: When the Migration Information page appears, select
Perform migration.

2. Perform the Instructions.html Tasks

Follow the steps in the Instructions.html file.

Post-Promotion Tasks

Perform the post-promotion tasks as described in “Part 6. Post Process Tasks.”
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Overview

This chapter contains tasks that must be performed after you complete the steps
for either of the following processes:

installation and migration
system promotion

Note: A fully-promoted system should, with few exceptions, be identical in
content and functionality to the original system except that it might be
differently hosted. This chapter contains tasks that must be performed after
the full promotion of one SAS Strategy Management 5.6 installation to
another is complete.

Completing the tasks in this chapter requires the following:

You must have completed the steps that are outlined for your applicable
migration or system promotion.

You must have access to SAS Management Console in the SAS 9.4
installation.
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Apply File Permissions

Before you perform any of the tasks in this chapter, apply file permissions as
described in the SAS Strategy Management: System Administration Guide.
Otherwise, some tasks in this chapter will fail.

In particular, apply the following permissions to the sAs-config-dir
\Lev1l\SASMain\Data directory and its subdirectories:

For Windows Grant Full Control to SAS General Server User (sassrv). Grant
installations Read/Write/Modify permission to users who run ETL or SAS jobs
to update data in the warehouse.

For UNIX Permit full access for the SAS General Server User (sassrv).
installations Grant Read/Write/Execute permission to subdirectories for users
who run ETL or SAS jobs through the use of group permissions.

Complete the Migration of Specific
Features

The content that you must manually migrate is listed as items excluded in the

“What Can Be Migrated?” section of the SAS 9.4 Intelligence Platform: Migration
Guide.

For system promotions, these items include:
autoexec files and sasv9.cfg
custom portlet code

custom metadata

Depending on the installation that you are migrating, some features are not

migrated or are not completely migrated. Review the following table to determine
if your installation contains any of the affected features.
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Copy Stored Process Files

The SAS migration process migrates only stored processes that are located in
the sas-config-dir\Levl directory or its subdirectories. If your stored
processes, such as those used in links, are located in another directory, then
execution of the stored processes appears to fail.

To correct the problem:

If the affected stored process is not located on a common shared network
drive, copy the stored process directory and files from the source system to
the target system.

If the file path on the target system is different than the file path on the
source system, use SAS Management Console to locate the stored process
folder location in metadata. Update the stored process metadata to add or
update its Source Code Repository path, using the file path for the stored
process on the target system.

Note: For more information, see “Migrating Content Stored Outside of the SAS
Configuration Directory” in SAS 9.4 Intelligence Platform: Migration Guide.

Correct the Web Address

Web addresses in SAS Strategy Management providers for SAS Bl Dashboard
are incorrect after a changehost is performed. The incorrect Web addresses
affect the SAS Strategy Management indicators that appear in dashboards.

To correct a Web address in a SAS Strategy Management provider:
1 Log on to SAS Management Console.
2 Click the Folders tab.

3 Navigate to the location of the affected SAS Strategy Management provider.
This location is the same name as the folder where you accessed the SAS
Strategy Management provider in the SAS Information Delivery Portal (for
example, Shared Data).

4 Right-click the provider that you want to modify. The file has an .imx
extension.

5 Select Write Contents to External File.
6 Complete the fields in the target file window and click Save.

7 In a file navigation window, locate the external file that you just created.
Right-click the file and select Edit.

8 Locate the authenticationServiceURL attribute in the ModelQuery tag.
9 Modify this Web address to the correct Web address and save the file.

10 In SAS Management Console, right-click the folder that contains the .imx file.
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11 Select Add Content From External File(s) or Directories.
12 Navigate to the modified .imx file, select it, and click Open.
13 (Optional) Add a description.

14 Confirm that the original file that is stored in SAS Content Server has been
overwritten and replaced.

15 Log on to a new SAS Bl Dashboard session to confirm your changes.

Tasks for Migrations from Version 5.1 or
Version 5.2

Overview

These tasks apply to those migrating from Version 5.1 or 5.2 installations.

Correct the Presence of Solutions Users Group

After migration, some projects on the target server might show that SAS
Strategy Management objects within the project have Solutions Users group
permissions assigned even though no explicit object permissions have been
assigned. Click Project » Security Administration. The Security
Administration - Project Permissions Display page appears. The Solutions Users
group appears in the Identity column for all of the objects in the table.

In a migration installation of SAS Strategy Management, there are installation-
wide default object permissions for each type of SAS Strategy Management
secured object that was migrated. These default permissions are used for a
secured object when there are no explicit or inherited permissions available for
that object. If a SAS Strategy Management object is using default permissions,
adding a permission overrides the default.

When the administrator adds a new user or group to the affected SAS Strategy
Management object, the Solutions Users group no longer appears.

Review New Roles and Capabilities
Note: This task applies to those migrating from Version 5.1 or 5.2 installations.

SAS Strategy Management 5.6 provides some new roles and capabilities. For
information, see “Securing Access to SAS Strategy Management” in the SAS
Strategy Management 5.6: System Administration Guide.

Copy Diagram Image Files

Note: This task applies to:

Version 5.5 installations migrated to Version 5.6
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Version 5.6 installations promoted to another system

Depending on the source system from which you migrated, diagram image files
might not be copied during the migration and diagrams seem to fail.

To correct the problem:

1 In the SAS Strategy Management Builder, open the Project Options page.
Clear or disable the diagram cache. Then, open a diagram to determine
whether it is displayed correctly.

2 If images are still missing, copy the diagram image files from the source
system to the target system in both the WebApp War and CustomContent
directories. For example:

WebApp: C:\sas\Config\Levl\Web\WebAppServer
\sSAssServerll 1\sas webapps\sas.strategymanagement.war
\images\customer

CustomContent: ¢:\sas\Config\Levl\Web\Common
\SASServerll\SASStrategyManagement5.6\CustomContent\wars
\sas.strategymanagement\images\customer
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Validate the Installation

After you perform the post-migration tasks, validate the installation:

1 Perform the post-configuration tasks that are described in “Performing Post-
Configuration Steps” in the SAS Strategy Management 5.6: System
Administration Guide.

2 Perform the validation tasks that are described in the Instructions.html file on
the middle tier.

3 Check for content that you know is present in the source SAS configuration.

You can also run the authorization differences reports. Those reports are
described in the “Performing Post-migration Tasks” chapter of the SAS 9.4
Intelligence Platform: Migration Guide. These reports identify differences in
access to libraries, tables, folders, OLAP schemas, and cubes between the
source and target SAS installations. See also What's New in SAS 9.4
Intelligence Platform and What's New in SAS Information Delivery Portal.

For more information about changes that are specific to SAS Strategy
Management, see “What's New in SAS Strategy Management 5.6” in the SAS
Strategy Management 5.6: System Administration Guide.



110 Chapter 24 / Validate the Installation



111

Changes in Version 5.6

SAS 9.4 Support 111
SAS Web Application Server Support 111
New Internal Database 111
Removal of ODCS Support 112

SAS 9.4 Support

SAS 9.4 contains some key enhancements including an embedded middle-tier
web application server and support for only 64-bit Windows environments.

SAS Web Application Server Support

SAS Strategy Management no longer requires or supports external third-party
application servers (JBoss, WebSphere, and WebLogic). Some of the benefits of
this new feature include the following:

cost reduction by eliminating external application servers
higher availability by eliminating remote services

integrated support for enterprise authentication systems, including
WebSEAL, SiteMinder, and IWA

New Internal Database

SAS Strategy Management, Versions 5.5 and 5.6, includes a new internal
database, PostgreSQL. SAS Strategy Management directly accesses and
updates the database. IT maintenance and administration are not required. This
database is fully supported by SAS Technical Support.
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Removal of ODCS Support

SAS Strategy Management 5.6 does not provide support for ODCS and the
sharing of hierarchies with SAS Financial Management.

If you have migrated from a SAS Strategy Management Version 5.1, 5.2, or 5.3
installation to a SAS Strategy Management Version 5.6 installation, Time and
Hierarchy dimension definitions are migrated from the Solutions SASSDM to be
internally managed within the SPM database. These migrations are usually
transparent to users.

Time dimension hierarchies that are used by projects in SAS Strategy
Management Versions 5.1, 5.2, or 5.3 are migrated into a SAS Strategy
Management Time hierarchy definition with the same dimension name. If a
hierarchy-based project that includes a scorecard hierarchy was created and
synchronized with an FM/ODCS dimension hierarchy, the project continues to
function but is no longer synchronized with the FM/ODCS hierarchies.

Time hierarchies that are migrated are no longer maintained using SAS
Financial Management Studio or Solutions Dimension Editor. You can maintain
the migrated Time hierarchies by using the SAS Strategy Management Time
Period Set wizard. The wizard is located in SAS Strategy Management Builder.
For more information, see SAS Strategy Management 5.6: System
Administration Guide.
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What Is SAS Visual Analytics
Administration and Reporting Services?

If you have a SAS Strategy Management 5.6 installation and the migrated
installation does not include SAS Visual Analytics Administration and Reporting
Services, you can install the SAS Visual Analytics Administration and Reporting
Services as an add-on product by using the information in this chapter.

The SAS Visual Analytics Administration and Reporting Services provides the
following support:

generating SAS Strategy Management views into a SAS report that can be
viewed by using the SAS Mobile Bl app.

managing mobile devices and their access to SAS reports

Requirements

The following procedure does not include all of the steps that you must
complete. Instead, this procedure describes steps that are specific to the SAS
Strategy Management installation. To understand the entire procedure, ensure
that you review the following documentation:

SAS Intelligence Platform: Guide to Software Updates, “Adding a New
Product”

SAS Intelligence Platform: Installation and Configuration Guide, “Adding SAS
Products”
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You must have available the SAS Installation Depot which installed the SAS
Strategy Management installation to Version 5.6 or later. The SAS Visual
Analytics Administration and Reporting Services package is included in the
customer order. Currently this package is available for Linux (LAX) and Windows
Server (WX6) installations.

CAUTION! It is strongly recommended that you perform a full system backup
of all systems and tiers which will be affected by the add-on installation. In
some cases, the backup might be the only feasible restoration option in a multi-
system installation.

Install the SAS Visual Analytics
Administration and Reporting Services

You must perform the installation on each tier in the same order as the original
installation.

Note: If the SAS Installation Depot contains other products that were not
previously installed in addition to the SAS Visual Analytics Administration and
Reporting Services, these additional products are added to the installation
according to the plan file specifications.

The following instructions exist within the context of the sections called “Add
SAS Products that Require Configuration” and “Configuring SAS Products” in
SAS Intelligence Platform: Installation and Configuration Guide.

1 Shut down all SAS services and close all SAS sessions.

2 In the SAS Deployment Wizard, on the Select Deployment Type page,
select Perform a Planned Deployment.

3 Select Install SAS Software and click Next.

4 On the Specify Deployment Plan page, select Specify the full path to a
customized deployment plan. Enter the path to the plan or click Browse to
navigate to and select the location. Click Next.

5 On the Select Products to Install page, from the Machine list, select Server
and Middle Tier. Click Next.

6 On the Select SAS Add-in for Microsoft Office Mode page, select 64-bit
Native Mode and click Next.

7 On the Specify SAS Installation Data File page, enter the path to the file or
click Browse to navigate to and select the file. Click Next.

8 On the Select Language Support page, select the language to install. Click
Next.

9 On the Select Microsoft Office Applications page, select the applications that
you want to install. Click Next.

10 On the Checking System page, the SAS Deployment Wizard initializes and
checks for conflicts and required space in the file system. When the progress
bars indicate complete, click Next.
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11 On the Review Required Software page, review the software that will be
installed and click Next.

12 On the Specify Software Location page, enter the path to the software or
click Browse to navigate to and select the location. Click Next.

Note: This step repeats for each software that is listed as required on the
Review Required Software page.

13 On the Deployment Summary page, review your selections. Then, click
Start.

Depending on the software components that are being installed, the
installation might require that you restart the system. If the system restart is
required and the SAS Deployment Wizard does not subsequently restart, you
must manually restart the wizard.

14 The SAS Deployment Manager opens and asks to configure your location.
Click Cancel.

15 Select Start » Administrative Tools » Services to start the Microsoft
Management Console Snap-in for Managing Services. Shut down the
metadata server and other SAS services that might have started when the
system restarted.

16 Start the SAS Deployment Wizard again.

17 Repeat steps 2 through 13. After you click Start, the SAS installation
resumes.

If the SAS installation requests to restart the system again, click Cancel.

18 On the Deployment Complete page, the installation reports its status. Click
Next.

19 On the Additional Resources page, click Finish.

When the installation is complete, go to “Configure the SAS Visual Analytics
Administration and Reporting Services” on page 115.

Configure the SAS Visual Analytics

Administration and Reporting Services
You must perform the configuration on each tier in the same order as the original
installation.

The following instructions exist within the context of the sections called “Add
SAS Products that Require Configuration” and “Configuring SAS Products” in
SAS Intelligence Platform: Installation and Configuration Guide.

1 Shut down all SAS services and close all SAS sessions.

2 Inthe SAS Deployment Wizard, on the Select Deployment Task page,
select Install SAS software click Next.

3 On the Select Deployment Type page, select Perform a Planned
Deployment.
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4 Select Configure SAS Software and click Next.

5 On the Specify Deployment Plan page, select Specify the full path to a
customized deployment plan. Enter the path to the plan or click Browse to
navigate to and select the location. Click Next.

6 On the Select Deployment Step page, from the Deployment Step list, select
Step 1: Server and Middle Tier. Click Next.

7 On the Checking System page, the SAS Deployment Wizard initializes and
checks for conflicts and required space in the file system. When the progress
bars indicate complete, click Next.

8 On the Select Configuration Prompting Level page, select Typical and click
Next.

9 On the Specify Configuration Information page, enter the path to the
configuration directory or click Browse to navigate to and select the location.

10 From the Configuration Level list, select Lev1 and click Next.
11 A confirmation message appears. Click Yes.

12 On the Select Products to Configure page, ensure that the following
selections are made and click Next.

SAS Visual Analytics Configuration Data
SAS Visual Analytics Extensions for Services
SAS Visual Analytics Services

SAS Visual Analytics Administrator
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SAS Deployment Wizard

Select Products to Configure
Select the products wou want to configure on this machine,

Product Search: Find Mext |

117

Product

[ 545 Metadata Server Configuration

[ 545 Management Console

[~ 5AS Web Infrastructure Platform Data Server Configuration

[~ 5AS Object Spawner

[~ Operating System Services Scheduling Server

[~ 545 DATA Step Batch Server

[~ 545 OLAP Server Configuration

[ 545 Pooled Workspace Server

[ 545 Stored Process Server

[~ 5AS Waorkspace Server

[~ SAS/COMMECT Server Configuration

[~ s5AS add-in For M5 Office Server Data

[~ 545 EI Report Services Workspace Configuration

[~ 545 Data Integration Studio Server Data

[ 543 Management Console Server Data

¥ 545 Yisual Analytics Configuration Cata

[+ SAS Yisual Data Builder Configuration Caka

[~ SASBI Lineage Scheduling Server

[~ 543 Web Infrastructure Platform Scheduling Services

[~ 545 EI Report Services

[~ 545 EI Dashboard Configuration Data

v 545 Yisual Analytics Server Components Configuration

[ 543 Information Retriewval Studio For 545

[ 545 Strategy Management Data-Tier

[~ 5AS Web Server Configuration

[~ 5AS Web Application Server Configuration

[~ SAS Foundation Services

[~ 545 Wehb Infrastructure Platform

[~ 545 Flex Application Themes

[ 543 web Application Themes

[ 545 Deployment Backup and Recovery Tool

[ 545 Yisual Analvtics Extensions for Services

[~ Search Interface bo 545 Conkent

¥ 5AS Yisual Analyvtics Services

[~ 545 Web Report Studio

[w 545 Wisual Analytics Hub

[v 545 Yisual Analytics Report Yiewer

¥ 545 Yisual nalytics sdmiriskrator

[ 545 Information Delivery Portal
al Data Builder

[~ 5AS shared Services

[~ sASBI Dashboard

[~ 545 Help Yiewer For Midtier Applications

[~ SASEI Portets

[ 543 Environment Manager Mid-Tier

[T SAS Strateav Management Extensions For 545 BI Dashboard

Select Al | Clear All

Help | < Back I Mext = I Cancel

The remaining steps through the SAS Deployment Wizard are documented

in SAS Intelligence Platform: Installation and Configuration Guide and do

not
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require any information specific to SAS Strategy Management or SAS Visual
Analytics.

13 On the Deployment Summary page, review your selections and then click
Start.

14 On the Deployment Complete page, the configuration reports its status. Click
Next when complete.

15 On the Additional Resources page, click Finish.
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Partial Promotion Migration

Overview 121
Situations That Require Partial Promotion 121
Tools for Partial Promotion 122
Release Promotion Procedures for Strategy Management Data 123

Overview

The SAS Migration Utility is the preferred way to migrate from earlier versions of
SAS Strategy Management to Version 5.6.

However, for situations in which you cannot use the SAS Migration Utility, you
can use the partial promotion tools that are shipped with SAS Strategy
Management and additional tools that are available for download from SAS
Technical Support as Tool Pool items. These tools are available to both
consultants and customers as downloads on or shortly after the official product
ship date.

Situations That Require Partial Promotion

The following situations are examples of when you might use an alternative to
the SAS Migration Ultility:

the topology of the two systems is different.

a site has a SAS 9.4 Enterprise Bl Server production environment in which
users are actively editing content. At a later date, the site decides to install
SAS Strategy Management 5.5 in the SAS Enterprise Bl Server environment
and to migrate their SAS Strategic Performance Management 2.4 content to
SAS Strategy Management 5.5.

the site has systems in parallel: a production server in use and a new
production server.

The SAS Strategy Management production server continues to run on
another system (or set of systems). Meanwhile, you prepare a new SAS
Strategy Management 5.5 server to be the new production server.

When you are ready to make the SAS Strategy Management 5.5 server the
production server, you must move any content changes from the Version 2.4,
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5.1, 5.2, 5.3, or 5.4 server to the Version 5.5 server. You can use the partial
promotion tools to move this content.

a site has development, test, and production servers running SAS Strategy
Management 5.4.

Tools for Partial Promotion

SAS Strategy Management provides the following tools for partial promotion:

Export SQL Files: See “Exporting and Importing Strategy Management
Data” in SAS Strategy Management 5.3: User’s Guide.

Export: For information about export, see the SAS Strategy Management
5.5: System Administration Guide.

Batch Maintenance Facility: For more information, see the following
applicable documents:

SAS Strategy Management 5.1: Batch Maintenance Facility User’s Guide
SAS Strategy Management 5.2: Batch Maintenance Facility User’s Guide
SAS Strategy Management 5.3: System Administration Guide
SAS Strategy Management 5.4: System Administration Guide
SAS Strategy Management 5.5: System Administration Guide
SAS Strategy Management 5.6: System Administration Guide

These documents are available at http://support.sas.com/
documentation/onlinedoc/stm/index.html.

SAS Strategy Management Data-tier Migration Tool: This is a tool script
available from SAS Technical Support. The tool performs the same data
transformation steps as in the SAS Deployment Wizard spmdatatier
migrations without requiring that you run a full migration and installation with
SAS Deployment Wizard.

This tool allows direct migration of the SPM database and related content
from Versions 2.4, 5.1, 5.2, and 5.3 to Versions 5.3. Full documentation,
including usage instructions, capabilities, and limitations, is available with the
download from SAS Technical Support.


http://support.sas.com/documentation/onlinedoc/stm/index.html
http://support.sas.com/documentation/onlinedoc/stm/index.html
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Release Promotion Procedures for Strategy
Management Data

The following table describes the partial promotion procedures for versions of
SAS Strategy Management.

Table A1.1  Source and Target Versions of SAS Strategy Management and Their Conversion Procedures

Source Target Conversion Procedure
24 5.1 Complete the following procedures:
5.2 Export the SQL files from the source installation of SAS Strategy

Management. See “Exporting and Importing Strategy Management Data” in
SAS Strategy Management 5.3: User’s Guide.

Use the conversion script that is available from SAS Technical Support. Ask
for the conversion script in SAS Note 37807. This script converts the SQL
files as part of its processing.

Import the SQL files into the target installation of SAS Strategy
Management. See “Exporting and Importing Strategy Management Data” in
SAS Strategy Management 5.3: User’s Guide.



124 Appendix 1 / Partial Promotion Migration

Source Target Conversion Procedure
24 5.3 There is no conversion script tool available to convert the SQL files. You must
5.4 complete one of following procedures:

perform a two-phase SAS Migration Utility migration and installation:

1 from SAS Strategic Performance
Management 2.4 to SAS Strategy
Management 5.2.

Note: See Part 1. “Migrating from SAS
9.1.3 to SAS 9.2” in SAS Strategy
Management 5.4: Migration Guide.

2 from SAS Strategy Management 5.2 to
SAS Strategy Management 5.4.

Note: See Part 2. “Migrating from SAS 9.2
to SAS 9.3” and Part 3. “Migrating from
SAS Strategy Management 5.3 to Version
5.4 on SAS 9.3” in SAS Strategy
Management 5.4: Migration Guide.

export, convert, and import the SQL files:

1 Export the SQL files from the source
installation of SAS Strategy Management.
See “Exporting and Importing Strategy
Management Data” in SAS Strategy
Management 5.3: User’s Guide.

2 Run the SAS Strategy Management Data-
tier Migration Tool.

3 Import the SQL files into the target
installation of SAS Strategy Management.
See “Exporting and Importing Strategy
Management Data” in SAS Strategy
Management 5.3: User’s Guide.

2.4 5.6 There is no conversion script tool available to convert the SQL files. You must
perform a two-phase SAS Migration Utility migration and installation:

Phase 1: from SAS Strategic Performance Management 2.4 to SAS
Strategy Management 5.2

Note: See Part 1. “Migrating from SAS 9.1.3 to SAS 9.2” in SAS
Strategy Management 5.4: Migration Guide.

Phase 2: from SAS Strategy Management 5.2 to SAS Strategy
Management 5.6

Note: See Part 2. “Migrating from SAS 9.2 to SAS 9.4 in SAS Strategy
Management 5.6: Migration Guide.
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Source Target Conversion Procedure

51 5.3 There is no conversion script tool available to convert the SQL files. You must
5.9 5.4 complete one of following procedures:

perform a SAS Migration Utility migration and installation from SAS Strategy
Management Versions 5.1 or 5.2 to Version 5.3 or 5.4.

Note: See Part 2. “Migrating from SAS 9.2 to SAS 9.3” in SAS Strategy
Management 5.4: Migration Guide.

export, convert, and import the SQL files:

1 Export the SQL files from the source
installation of SAS Strategy Management.
See “Exporting and Importing Strategy
Management Data” in SAS Strategy
Management 5.3: User’s Guide.

2 Run the SAS Strategy Management Data-
tier Migration Tool.

3 Import the SQL files into the target
installation of SAS Strategy Management.
See “Exporting and Importing Strategy
Management Data” in SAS Strategy
Management 5.3: User’s Guide.

51 5.6 There is no conversion script tool available to convert the SQL files. Perform a
5.9 SAS Migration Utility migration and installation from SAS Strategy
' Management Versions 5.1 or 5.2 to Version 5.6.

Note: See Part 2. “Migrating from SAS 9.2 to SAS 9.4” in SAS Strategy
Management 5.6: Migration Guide.

53 5.3 There is no conversion script tool available to convert the SQL files. You must
complete one of following procedures:

perform a same release SAS Migration Utility migration and installation from
SAS Strategy Management Versions 5.3 to Version 5.3.

Note: See SAS Strategy Management 5.4: Migration Guide.
export, convert, and import the SQL files:

1 Export the SQL files from the source
installation of SAS Strategy Management.
See “Exporting and Importing Strategy
Management Data” in SAS Strategy
Management 5.3: User’s Guide.

2 Run the SAS Strategy Management Data-
tier Migration Tool.

3 Import the SQL files into the target
installation of SAS Strategy Management.
See “Exporting and Importing Strategy
Management Data” in SAS Strategy
Management 5.3: User’s Guide.
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Source

5.3

5.3

5.4

5.5

5.5

Target

5.4

5.5
5.6

54
5.5
5.6

5.5

5.6

Conversion Procedure

Complete one of the following procedures:
perform a SAS Migration Utility migration and installation.

Note: See Part 3. “Migrating from SAS Strategy Management 5.3 to
Version 5.4 on SAS 9.3” in SAS Strategy Management 5.4: Migration
Guide.

perform an upgrade-in-place installation.

Note: See the “Upgrade-In-Place Installation” chapter in SAS Strategy
Management 5.4: Migration Guide.

Perform a SAS Migration Utility migration and installation.
Note: See Part 3. “Migrating from SAS 9.3 to SAS 9.4” in this book.

Complete one of the following procedures:
perform a SAS Migration Utility migration and installation.
Note: See Part 3. “Migrating from SAS 9.3 to SAS 9.4” in this book.

use the Package Export and Import feature that is available in SAS
Management Console. SAS Management Console can export and import
SAS Strategy Management projects and related content to other Version
5.4, or later, installations. This method is the recommended partial
promotion strategy. For more information about this feature, see the SAS
Strategy Management 5.6: System Administration Guide.

Complete one of the following procedures:
perform a SAS Migration Utility migration and installation.
Note: See Part 3. “Migrating from SAS 9.3 to SAS 9.4” in this book.

use the Package Export and Import feature that is available in SAS
Management Console. SAS Management Console can export and import
SAS Strategy Management projects and related content to other Version 5.5
installations. This method is the recommended partial promotion strategy.
For more information about this feature, see the SAS Strategy Management
5.5: System Administration Guide.

Complete one of the following procedures:
Perform a SAS Migration Utility migration and installation.
Note: See Part 3. “Migrating from SAS 9.3 to SAS 9.4” in this book.
Perform an upgrade-in-place installation.
Note: See Chapter 18, “Upgrade-In-Place Installation,” on page 81.

Use the Package Export and Import feature that is available in SAS
Management Console. SAS Management Console can export and import
SAS Strategy Management projects and related content to other Version 5.5
installations. This method is the recommended partial promotion strategy.
For more information about this feature, see SAS Strategy Management
5.5: System Administration Guide.
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Source Target Conversion Procedure

5.6 5.6 Complete one of the following procedures:
Perform a SAS Migration Utility migration and installation.

Note: See Part 4. “Migrating from SAS Strategy Management 5.5 to
Version 5.6 on SAS 9.4” in this book.

Use the Package Export and Import feature that is available in SAS
Management Console. SAS Management Console can export and import
SAS Strategy Management projects and related content to other Version 5.6
installations. This method is the recommended partial promotion strategy.
For more information about this feature, see SAS Strategy Management
5.6: System Administration Guide.
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Errors Running the SAS Migration Utility

Exception Caused by a Missing MySQL Password
(SAS Strategy Management 5.4 and Earlier)

The following message appears in the console window where SAS Migration
Utility is running:

The application script threw an exception: java.lang.Exception:
Missing DBMS USER PASSWORD property in SASCONFIG
\mysqldbs.properties

SAS Migration Utility is not able to process the DBMS_USER_PASSWORD _E
property in order to get the encoded MySQL password. It can process only the
DBMS_USER_PASSWORD property that contains the clear-text (unencoded)
password, and this property does not exist in the mysqldbs.properties file.

To resolve the problem:

1 In the console window where the SAS Migration Ultility is running, select 2 to
quit if you have not done so already.

2 On the data tier of the SAS 9.2 or 9.3 system, edit the SAS-config-dir
\mysqgldbs.properties file and add a line like the following:

DBMS_USER_PASSWORD=password

3 Replace password with the clear-text MySQL password. Save the file and
rerun SAS Migration Utility on this system.
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4 Complete the applicable step:

For Windows

For UNIX

Open a command window in the directory in which you
installed the SAS Migration Utility and submit the following
command:

smu93 x64.exe -properties
"full path to SMU install directory
\smu.properties" —replace

Note: In the previous commands,
full_path_to_SMU_install_directory\smu.properties must be
enclosed in double quotation marks only if there is a space in
the pathname.

Note: You must specify the full path to the smu.properties file
in the -PROPERTIES option, even though the smu.properties
file is in the current directory (the same directory as the
smu.exe file). Because smu.exe is actually a self-extracting
archive, it extracts the complete program into a separate
temporary directory and runs it from there.

After a few seconds, a second command window appears with
the SAS Migration Utility console output.

Submit the following command (line break added for
readability):

./smu93.sh -- -outputdir /usr/local/SAS/smupackage
-properties /usr/local/SAS/smu/smu.properties

Note: The output directory should not be the same as the
SAS Migration Ultility installation directory.

5 For security, after the SAS Migration Utility completes successfully, delete

the DBMS_USER_PASSWORD line from mysqldbs.properties. Leave the
DBMS_USER_PASSWORD E line in place.

Exception Caused by a Missing PostgreSQL
Password (SAS Strategy Management 5.5 and

Later)

The following message appears in the console window where SAS Migration

Utility is running:

The application script threw an exception: java.lang.Exception:

Missing DBMS USER PASSWORD property in smu.properties

SAS Migration Utility is not able to process the DBMS_USER_PASSWORD_E
property in order to get the encoded PostgreSQL password. It can process only
the DBMS_USER_PASSWORD property that contains the clear-text
(unencoded) password, and this property does not exist in the
mysqldbs.properties file.

To resolve the problem:

1

In the console window where the SAS Migration Utility is running, select 2 to
quit if you have not done so already.

On the data tier of the SAS 9.4 system, edit the smu.properties file and
add a line like the following:
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DBMS_USER_PASSWORD=password

3 Replace password with the clear-text PostgreSQL password. Save the file
and rerun SAS Migration Utility on this system.

4 Complete the applicable step:

For Windows Open a command window in the directory in which you
installed the SAS Migration Utility and submit the following
command:

smu94 x64.exe -properties
"full path to SMU install directory
\smu.properties" —replace

Note: In the previous commands,
full_path_to_SMU_install_directory\smu.properties must be
enclosed in double quotation marks only if there is a space in
the pathname.

Note: You must specify the full path to the smu.properties file
in the -PROPERTIES option, even though the smu.properties
file is in the current directory (the same directory as the
smu.exe file). Because smu.exe is actually a self-extracting
archive, it extracts the complete program into a separate
temporary directory and runs it from there.

After a few seconds, a second command window appears with
the SAS Migration Utility console output.

For UNIX Submit the following command (line break added for
readability):
./smu94.sh -- -outputdir /usr/local/SAS/smupackage

-properties /usr/local/SAS/smu/smu.properties

Note: The output directory should not be the same as the
SAS Migration Ultility installation directory.

5 For security, after the SAS Migration Utility completes successfully, delete
the DBMS_USER_PASSWORD line from smu.properties. Leave the
DBMS_USER_PASSWORD E line in place.

Problems Running SAS Data Integration
Studio Jobs

Overview

If you experience difficulties running a migrated job, check the following common
issues first.

Broken Mappings

After the migration process, there might be some broken mappings because of
the difference between data models or for other reasons. To fix these problems:

1 Open the job in the Job Editor window.



132 Appendix 2 / Troubleshooting

2 Click Map Job to enable automatic column mapping.

Clicking Map Job enables automatic mapping for the transformations in the
current job. For more information, see “Maintaining Column Mappings” in the
online Help for SAS Data Integration Studio.

3 If the transformations are correct, select File » Save.

Data Access Problems

If there are problems with data access, make sure that table libraries, especially
those for custom jobs, are updated to include new data locations, DBMS
settings, and similar information.

Problems with Lookup Transformations

If there are issues with a lookup transformation in a migrated job (for example, a
table that does not connect to the lookup), replace the transformation with the
Lookup transformation found on the Transformations tab, in the Data
directory.
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